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Preface

Oracle Identity Manager Connector Guide for PeopleSoft User Management provides 
information about integrating Oracle Identity Manager with PeopleSoft User 
Management.

Audience
This guide is intended for users who want to deploy the Oracle Identity Manager 
connector for PeopleSoft User Management.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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Related Documents
For information about installing and using Oracle Identity Manager, see the Oracle 
Identity Manager documentation library.

For generic information about connectors, see Oracle Identity Manager Connector 
Concepts.

The following Oracle Technology Network page provides links to Oracle Identity 
Manager documentation:

http://www.oracle.com/technology/documentation/oim.html

Documentation Updates
Oracle is committed to delivering the best and most recent information available. For 
information about updates to the Oracle Identity Manager Connector Pack Release 
9.0.4 documentation library, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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 What's New in the Oracle Identity Manager
Connector for PeopleSoft User

Management?

This chapter provides an overview of the updates made to the software and 
documentation for the PeopleSoft User Management connector in releases 9.0.4.1 of 
the Oracle Identity Manager connector pack.

The updates discussed in this chapter are divided into the following categories:

■ Software Updates

These include updates made to the connector software.

■ Documentation-Specific Updates

These include major changes made to the connector documentation. These 
changes are not related to software updates.

Software Updates
This section discusses updates made to this release of the connector software.

New Supported Target Systems
This release of the connector supports PeopleTools 8.47 and 8.48. The required content 
has been added at appropriate places in this guide.

Documentation-Specific Updates
The following documentation-specific updates have been made in this release of the 
guide:

■ At some places in the guide, the name of the target system has been changed from 
"PeopleSoft User Management" to "PeopleSoft Enterprise Applications."

■ In the "Lookup Fields Reconciliation" section on page 1-2, some lookup fields have 
been modified.

See Also: The 9.0.4 release of this guide for information about 
updates that were new for the 9.0.4 release

See Also: Oracle Identity Manager Release Notes
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■ In the "User Reconciliation" section, the object fields have been divided into single 
value and multi value object fields.

■ Information on "Full reconciliation" on page 1-1 and "Incremental reconciliation" 
on page 1-1 has been modified.

■ In the "Files and Directories That Comprise the Connector" section on page 1-6, the 
paths for some files have been modified.

■ In the "Step 1: Verifying Deployment Requirements" section on page 2-1, the target 
systems and the external code information have been modified.

■ In the "Step 2: Copying the Connector Files and External Code Files" section on 
page 2-2, the destination directory path for the peopleSoftUserMgmt.war file 
has been modified.

■ The structure of the Configuring the Target System section on page 3-1 has been 
modified.

■ The structure of the "Configuring Reconciliation" section on page 3-17 has been 
modified.

■ In the "User Reconciliation Scheduled Task" subsection of the "Specifying Values 
for the Scheduled Task Attributes" section on page 3-19, the following attributes 
have been added:

– NoOfRecordsToBeReconciled

– Operator

– UserID

– UserType

■ In the "Multilanguage Support" section, Arabic has been added to the list of 
languages that the connector supports.
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1
About the Connector

Oracle Identity Manager automates access rights management, security, and 
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate 
Oracle Identity Manager with third-party applications. This guide discusses the 
procedure to deploy the PeopleSoft User Management connector that is used to 
integrate Oracle Identity Manager with PeopleSoft Enterprise Applications.

The PeopleSoft User Management connector helps you to manage the PSOPRDEFN 
PeopleTools-based PeopleSoft applications account records including Role and 
Permission List assignments through target resource reconciliation, trusted source 
reconciliation, and provisioning. The connector supports user data reconciliation in 
two ways:

■ Full reconciliation

Full reconciliation involves reconciling records of existing users by using a flat file. 
A PeopleCode event is activated when user information is updated in PeopleSoft 
Enterprise Applications. The PeopleCode then extracts the required user account 
information. A PeopleSoft Application Engine program then populates the flat file 
with this information. The flat file is read by an Oracle Identity Manager 
scheduled task that generates reconciliation events. 

The PeopleSoft Application Engine program is run using PeopleSoft Application 
Designer or PeopleSoft Internet Architecture (PIA).

To reconcile all existing target system records into Oracle Identity Manager, you 
must run full reconciliation the first time you perform a reconciliation run after 
deploying the connector. This is to ensure that the target system and Oracle 
Identity Manager contain the same data. In subsequent reconciliation runs, only 
data that is modified since the last reconciliation is reconciled. Oracle recommends 
that you run full reconciliations periodically to ensure that all the user records are 
reconciled into Oracle Identity Manager. See "Configuring the Target System for 
Full Reconciliation" on page 3-1 for more information.

■ Incremental reconciliation

Incremental reconciliation involves real-time reconciliation of newly created or 
modified user account information. Usually, this type of reconciliation is used for 
reconciling individual data changes after an initial reconciliation is performed 

Note: In this guide, the term Oracle Identity Manager server refers 
to the computer on which Oracle Identity Manager is installed.

At some places in this guide, PeopleSoft Enterprise Applications has 
been referred to as the target system.
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using full reconciliation. The PeopleCode captures changes to the same PeopleSoft 
components as applicable for full reconciliation and forwards these changes in real 
time to a Java Servlet listener running on the Oracle Identity Manager server 
through an HTTP POST request. Incremental reconciliation is performed using 
PeopleSoft application messaging. See "Configuring the Target System for 
Incremental Reconciliation" on page 3-4 for more information.

The synchronization process from the target system to Oracle Identity Manager 
involves the following steps:

1. When user account information is added or updated in the target system, a 
PeopleCode event is activated.

2. The PeopleCode event generates an XML message containing the added or 
updated user account information and sends it to the connector by using 
HTTP.

3. The connector parses the XML message and sends a reconciliation event to 
Oracle Identity Manager.

This chapter contains the following sections:

■ Reconciliation

■ Provisioning

■ Supported Functionality

■ Multilanguage Support

■ Files and Directories That Comprise the Connector

■ Determining the Release Number of the Connector

Reconciliation

Based on the type of data reconciled from the target system, reconciliation can be 
divided into the following types:

■ Lookup Fields Reconciliation

■ User Reconciliation

Lookup Fields Reconciliation
During the creation or modification of user accounts, a lookup field is used to specify 
one value from a set of values. The value that you select populates one of the attributes 
of the user account. Lookup field reconciliation is used to reconcile the following 
lookup field values from the target system into Oracle Identity Manager:

■ LanguageCode

■ EmployeeId

■ CurrencyCode

■ PermissionList

■ EmailTypes

See Also: The "Deployment Configurations of Oracle Identity 
Manager" section in Oracle Identity Manager Connector Concepts Guide 
for conceptual information about reconciliation configurations
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The EmailTypes lookup field is reconciled only in PeopleTools 8.45 through 8.48, 
because PeopleTools 8.22 does not support multiple e-mail types.

■ Roles

User Reconciliation
User reconciliation involves reconciling user account information from the target 
system into Oracle Identity Manager. The information that is reconciled is different for 
target resource and trusted source reconciliation.

User Fields Reconciled During Target Resource Reconciliation
The following single-valued target system fields are reconciled during target resource 
reconciliation:

■ UserId

■ UserDescription

■ EmployeeId

■ MultiLanguageCode

■ LanguageCD

■ CurrencyCode

■ UserIdAlias (PeopleTools 8.45 through 8.48 only)

■ RowSecurity

■ ProcessProfile

■ NavigatorHomePage

■ Primary

■ Role

The following multivalued target system fields are reconciled during target resource 
reconciliation:

■ PrimaryEmailAddress (PeopleTools 8.45 through 8.48 only)

■ PrimaryEmailType (PeopleTools 8.45 through 8.48 only)

■ Email Address (PeopleTools 8.22 only)

■ Secondary EmailAddresses (PeopleTools 8.45 through 8.48 only)

■ Secondary EmailTypes (PeopleTools 8.45 through 8.48 only)

User Fields Reconciled During Trusted Source Reconciliation
The following target system fields are reconciled during trusted source reconciliation:

■ User ID

■ First Name

■ Last Name

■ Organization

■ User Type

■ Employee Type
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Provisioning
Provisioning involves creating or modifying a user's account information on the target 
system through Oracle Identity Manager. You use the Oracle Identity Manager 
Administrative and User Console to perform provisioning operations.

You can specify values for the following target system fields during a provisioning 
operation:

■ UserId

■ UserDescription

■ Primary

■ RowSecurity

■ ProcessProfile

■ NavigatorHomePage

■ SymbolicID

■ LanguageCode

■ CurrencyCode

■ PrimaryEmailAddress

■ PrimaryEmailType (for PeopleTools 8.45 and 8.48 only)

■ EmpId

■ RecName

■ Password

■ UserIdAlias (for PeopleTools 8.45 and 8.48 only)

■ MultiLanguageCode

Supported Functionality
The following table lists the functions that are available with this connector:

See Also: The "Deployment Configurations of Oracle Identity 
Manager" section in Oracle Identity Manager Connector Concepts Guide 
for conceptual information about provisioning

Note: The "PeopleTools Release" column of this table indicates the 
release of PeopleTools for which the corresponding function is 
available.

Table 1–1 Supported Functionality

Function PeopleTools Release Type Description

Add User 8.22 and 8.45 through 
8.48

Provisioning Creates a user account

Password Updated 8.22 and 8.45 through 
8.48

Provisioning Updates the password of a user
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User Description 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the description of a user

Multilanguage 
Code Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the multilanguage code of a user

Primary Email 
Address Updated

8.22 only Provisioning Updates the primary e-mail address of a 
user

Email Address 
Updated

8.22 only Provisioning Updates the e-mail address of a user

Primary Email 
Type Updated

8.45 through 8.48 only Provisioning Updates the primary e-mail address type 
of a user

Language Code 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the language code of a user

Currency Code 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the currency code of a user

Employee Id 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the employee ID of a user

Primary 
Permission List 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the Primary Permission list of a 
user

Process Profile 
Permission List 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the Process Profile Permission list 
of a user

Navigator Home 
Permission List 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the Navigator Home Permission 
list of a user

Row Security 
Permission List 
Updated

8.22 and 8.45 through 
8.48

Provisioning Updates the Row Security Permission list 
of a user

User Id Alias 
Updated

8.45 through 8.48 only Provisioning Updates the user ID alias of a user

Add RoleName 8.22 and 8.45 through 
8.48

Provisioning Adds a role to a user

Delete RoleName 8.22 and 8.45 through 
8.48

Provisioning Deletes a role from a user

Add 
EmailAddress

8.45 through 8.48 only Provisioning Adds an e-mail address to a user

Delete 
EmailAddress

8.45 through 8.48 only Provisioning Deletes the e-mail address of a user

Enables a User 8.22 and 8.45 through 
8.48

Provisioning Enables a user

Disables a User 8.22 and 8.45 through 
8.48

Provisioning Disables a user

Reconcile Lookup 
Field

8.22 and 8.45 through 
8.48

Reconciliation Reconciles lookup fields

Table 1–1 (Cont.) Supported Functionality

Function PeopleTools Release Type Description
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Multilanguage Support
The connector supports the following languages:

■ Arabic

■ Chinese Simplified

■ Chinese Traditional

■ Danish

■ English

■ French

■ German

■ Italian

■ Japanese

■ Korean

■ Portuguese (Brazilian)

■ Spanish

Files and Directories That Comprise the Connector
The files and directories that comprise this connector are compressed in the following 
directory on the installation media:

Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft User 
Management

These files and directories are listed in the following table:

Reconcile User 
Data

8.22 and 8.45 through 
8.48

Reconciliation Target resource reconciliation: This is the 
primary mode of reconciliation for this 
connector. In this mode, updates made to 
target system users who already exist in 
Oracle Identity Manager are reconciled.

This connector can also be configured in 
trusted source mode.

See Also: Appendix A for information about attribute mappings 
between Oracle Identity Manager and PeopleSoft Enterprise 
Applications.

See Also: Oracle Identity Manager Globalization Guide for information 
about supported special characters

File in the Installation Media Directory Description

config/attributemapping_prov.properties This file lists the target system attributes and their 
mappings to corresponding fields in Oracle Identity 
Manager during provisioning.

Table 1–1 (Cont.) Supported Functionality

Function PeopleTools Release Type Description
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config/attributemapping_recon.properties This file lists the target system attributes and their 
mappings to corresponding fields in Oracle Identity 
Manager during reconciliation.

ext/csv.jar This file is a third-party library that is used to read 
comma-separated files.

lib/PSFTBaseProvisioning.jar This JAR file contains the class files that are required for 
provisioning.

lib/PSFTBaseReconciliation.jar This JAR file contains the class files that are used to 
implement full reconciliation.

lib/peopleSoftUserMgmt.war This Web Archive (WAR) file contains the classes and 
configuration files required to implement incremental 
reconciliation.

For PeopleTools 8.22, the following files in the 
PeopleCode/PT822 directory:

AddEmp.txt
CurrencyCode.txt
EmployeeId.txt
LanguageCode.txt
PermissionList.txt
UserRoles.txt

For PeopleTools 8.45 through 8.48, the following 
files in the PeopleCode directory:

AddEmp.txt
CurrencyCode.txt
EmployeeId.txt
EmailType.txt
LanguageCode.txt
PermissionList.txt

These files contain the PeopleCode for the steps that you 
define for the Application Engine program. Refer to the 
"Creating the Application Engine Program" section on 
page 3-2 for details. 

For PeopleTools 8.22:

PeopleCode/PT822/UserMgmtCBRecon.txt

For PeopleTools 8.45 through 8.47:

PeopleCode/UserMgmtCBRecon_8.45-8.47.txt

For PeopleTools 8.48:

PeopleCode/UserMgmtCBRecon_8.48.txt

This file contains the code that you must add to the 
PeopleCode for the SavePostChange event while 
performing the procedure described in the "Publishing the 
Message" section on page 3-8.

For PeopleTools 8.22, the following file in the lib/ 
directory:

xliMsgPublisher.jar

This JAR file contains the class file that transfers the XML 
messages generated by the PeopleTools 8.22 file handler to 
the connector.

For PeopleTools 8.22, the following file in the 
scripts directory:

publish.bat

This BAT file is a Microsoft Windows batch file that 
triggers the XML message transfer on a periodic basis. 
Refer to the "Configuring PeopleSoft Integration Broker" 
section on page 3-10 for more information.

For PeopleTools 8.22:

test/cbrecon/PT822/psft-xel-test.vbs

For PeopleTools 8.45 through 8.48:

test/cbrecon/psft-xel-test.vbs

This VBScript file can be used to test the incremental 
reconciliation functionality of the connector by creating a 
dummy XML message similar to the ones created by 
PeopleSoft Enterprise Applications.

File in the Installation Media Directory Description
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For PeopleTools 8.22, the following files in the 
test/cbrecon/PT822 directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

For PeopleTools 8.45 through 8.48, the following 
files in the test/cbrecon directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

These XML files are required by the psft-xel-test.vbs 
file for communicating with the connector by using XML 
over HTTP.

For PeopleTools 8.22:

test/cbrecon/PT822/USR_MGMT_MSG.xml

For PeopleTools 8.45 through 8.48:

test/cbrecon/USR_MGMT_MSG.xml

This XML file is used by the psft-xel-test.vbs file to 
define the template of the XML message that is received 
from the target system.

test/config/config.properties This file is used to specify the parameters and settings 
required to connect to the target system by using the 
testing utility.

test/config/log.properties This file is used to specify the log level and the directory in 
which the log file is to be created when you run the testing 
utility.

test/scripts/psftBase.bat
test/scripts/psftBase.sh

The BAT file or UNIX shell script calls the testing utility 
when the Oracle Identity Manager server is running 
Microsoft Windows or UNIX, respectively. 

For PeopleTools 8.22, the files in the 
resources/PT822 directory

For PeopleTools 8.45 through 8.48, the files in the 
resources directory

Each of these files contains locale-specific information that 
is used by the connector.

For PeopleTools 8.22:

xml/PT822/PSFTBaseConnector.xml

For PeopleTools 8.45 through 8.48:

xml/PSFTBaseConnector.xml

This XML file contains definitions for the following 
components of the connector:

■ IT resource type

■ Scheduled Task

■ IT resource

■ Resource object

■ Process definition

■ Process tasks

■ Adapters

■ Process form

For PeopleTools 8.22:

xml/PT822/PSFTBaseXellerateUser.xml

For PeopleTools 8.45 through 8.48:

xml/PSFTBaseXellerateUser.xml

This XML file contains the configuration information for 
the Xellerate User resource object. You must import this file 
only if you plan to use the connector for trusted source 
reconciliation.

File in the Installation Media Directory Description
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The "Step 2: Copying the Connector Files and External Code Files" section on page 2-2 
provides instructions to copy these files into the required directories.

Determining the Release Number of the Connector
You can use the following method to determine the release number of a PeopleSoft 
User Management connector:

1. Extract the contents of the PSFTBaseReconciliation.jar file. This file is in 
the following directory on the installation media:

Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft User 
Management/lib/ScheduleTask

2. Open the manifest.mf file in a text editor. The manifest.mf file is one of the 
files bundled inside the PSFTBaseReconciliation.jar file.

In the manifest.mf file, the release number of the connector is displayed as the 
value of the Version property.
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2
Deploying the Connector

Deploying the connector involves the following steps:

■ Step 1: Verifying Deployment Requirements

■ Step 2: Copying the Connector Files and External Code Files

■ Step 3: Configuring the Oracle Identity Manager Server

■ Step 4: Importing the Connector XML File

Step 1: Verifying Deployment Requirements
The following table lists the deployment requirements for the connector.

Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later

Target systems PeopleTools 8.22, 8.45, 8.46, 8.47, 8.48

The PeopleSoft applications compatible with any of 
the PeopleTools versions in the preceding list are 
supported.

You must ensure that the following components are 
installed and configured:

■ Tuxedo and Jolt (the application server)

■ PeopleSoft Internet Architecture

■ PeopleSoft Application Designer (2-tier mode)

Target system host platform Applications running on PeopleTools 8.22 are 
supported only on Microsoft Windows platforms. 
For applications running on any other supported 
PeopleTools versions, there is no platform 
dependency.

External code csv.jar

Refer to the "Files and Directories That Comprise 
the Connector" section on page 1-6 for more 
information about this file.

The "Step 2: Copying the Connector Files and 
External Code Files" section on page 2-2 provides 
information about the required PeopleSoft files.
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Step 2: Copying the Connector Files and External Code Files
The connector files to be copied and the directories to which you must copy them are 
given in the following table:

Target system user account The PS account.

Oracle Identity Manager uses target system account 
to connect to and exchange data with the target 
system. You provide the credentials of this user 
while specifying the values for the IT resource 
parameter.

Note:

- The directory paths given in the first column of this table correspond 
to the location of the connector files in the following directory on the 
installation media:

Enterprise Applications/PeopleSoft Enterprise 
Applications/PeopleSoft User Management

Refer to the "Files and Directories That Comprise the Connector" 
section on page 1-6 for more information about these files.

- If a particular destination directory does not already exist on the 
Oracle Identity Manager server, then create it.

File in the Installation Media Directory Destination Directory

Files in the config directory OIM_HOME/xellerate/XLIntegrations/PSFTBase/config

lib/peopleSoftUserMgmt.war OIM_HOME/cbrecon_webapp/lib

ext/csv.jar OIM_HOME/xellerate/ThirdParty

lib/PSFTBaseProvisioning.jar OIM_HOME/xellerate/JavaTasks

lib/PSFTBaseReconciliation.jar OIM_HOME/xellerate/ScheduleTask

For PeopleTools 8.22, copy the files from the lib/ 
directory.

OIM_HOME/xellerate/MsgPublisher

For PeopleTools 8.22, copy the files from the 
PeopleCode/PT822 directory.

For PeopleTools 8.45 through 8.48, copy the files 
from the PeopleCode directory.

OIM_HOME/xellerate/scripts

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.48. Do not copy both sets of files. 

For PeopleTools 8.22, copy the files from the 
resources/PT822 directory.

For PeopleTools 8.45 through 8.48, copy the files 
from the resources directory.

OIM_HOME/xellerate/connectorResources

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.48. Do not copy both sets of files.

For PeopleTools 8.22, copy the files from the 
test/cbrecon/PT822 directory.

For PeopleTools 8.45 through 8.48, copy the files 
from the test/cbrecon directory.

OIM_HOME/xellerate/XLIntegrations/PSFTBase/cbrecon 

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.48. Do not copy both sets of files. 

Files in the test/scripts directory OIM_HOME/xellerate/XLIntegrations/PSFTBase/scripts

Files in the test/config directory OIM_HOME/xellerate/XLIntegrations/PSFTBase/config

Item Requirement
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After you copy the connector files, copy the following files from the 
PEOLESOFT_HOME/PT8xx/web/PSJOA directory on the target system server into the 
OIM_HOME/xellerate/ThirdParty directory.

■ psjoa.jar

This is the PeopleSoft Java object adapter file containing the compiled Java classes 
required by Oracle Identity Manager to remotely connect to the target system.

■ peoplesoft.jar

This JAR file contains APIs for the USER_PROFILE component interface.

The "Configuring the Target System for Provisioning" section on page 3-17 for 
information about the procedure to generate this file for the specific release of 
PeopleTools, 8.22 or 8.45 through 8.48, that you are using.

The pstools.properties file contains the Tuxedo parameter settings used by 
PeopleSoft Integration Broker Gateway. You must copy it into the 
OIM_HOME/xellerate/bin directory.

Step 3: Configuring the Oracle Identity Manager Server
Configuring the Oracle Identity Manager server involves the following procedures:

■ Changing to the Required Input Locale

■ Clearing Content Related to Connector Resource Bundles from the Server Cache

■ Enabling Logging

Changing to the Required Input Locale
Changing to the required input locale (language and country setting) involves 
installing the required fonts and setting the required input locale.

You may require the assistance of the system administrator to change to the required 
input locale.

For PeopleTools 8.22:

xml/PT822/PSFTBaseConnector.xml
xml/PT822/PSFTBaseXellerateUser.xml

For PeopleTools 8.45 through 8.48:

xml/PSFTBaseConnector.xml
xml/PSFTBaseXellerateUser.xml

OIM_HOME/xlclient

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.48. Do not copy both sets of files. 

Note: While installing Oracle Identity Manager in a clustered 
environment, you copy the contents of the installation directory to 
each node of the cluster. Similarly, you must copy all the JAR files and 
the contents of the connectorResources directory to the 
corresponding directories on each node of the cluster.

Note: In a clustered environment, you must perform these 
procedures on each node of the cluster.

File in the Installation Media Directory Destination Directory
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Clearing Content Related to Connector Resource Bundles from the Server Cache
While performing the procedure described in the "Step 2: Copying the Connector Files 
and External Code Files" section on page 2-2, you copy files from the resources 
directory on the installation media into the 
OIM_HOME/xellerate/connectorResources directory. Whenever you add a new 
resource bundle in the connectorResources directory or make a change in an 
existing resource bundle, you must clear content related to connector resource bundles 
from the server cache.

To clear content related to connector resource bundles from the server cache:

1. In a command window, change to the OIM_HOME/xellerate/bin directory.

2. Enter one of the following commands:

■ On Microsoft Windows:

PurgeCache.bat ConnectorResourceBundle

■ On UNIX:

PurgeCache.sh ConnectorResourceBundle

In this command, ConnectorResourceBundle is one of the content categories 
that you can remove from the server cache. Refer to the following file for 
information about the other content categories:

OIM_HOME/xellerate/config/xlconfig.xml

Enabling Logging
When you enable logging, Oracle Identity Manager automatically stores in a log file 
information about events that occur during the course of provisioning and 
reconciliation operations. To specify the type of event for which you want logging to 
take place, you can set the log level to one of the following:

■ ALL

This level enables logging for all events.

■ DEBUG 

This level enables logging of information about fine-grained events that are useful 
for debugging.

■ INFO  

This level enables logging of messages that highlight the progress of the 
application at a coarse-grained level.

■ WARN  

Note: You must perform Step 1 before you perform Step 2. An 
exception is thrown if you run the command described in Step 2 as 
follows:

OIM_HOME/xellerate/bin/script_file_name

Note: You can ignore the exception that is thrown when you perform 
Step 2. This exception is different from the one mentioned in Step 1.
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This level enables logging of information about potentially harmful situations.

■ ERROR 

This level enables logging of information about error events that may allow the 
application to continue running.

■ FATAL

This level enables logging of information about very severe error events that could 
cause the application to stop functioning.

■ OFF   

This level disables logging for all events.

The file in which you set the log level depends on the application server that you use:

■ BEA WebLogic

To enable logging:

1. Add the following line in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTBASE=log_level
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction=log_
level
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

For example:

log4j.logger.ADAPTER.PSFTBASE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction=DEBU
G
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG

After you enable logging, log information is written to the following file:

WEBLOGIC_HOME/user_projects/domains/domain_name/server_name/server_name.log

■ IBM WebSphere

To enable logging:

1. Add the following lines in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTBASE=log_level
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction=log_
level
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

For example:

log4j.logger.ADAPTER.PSFTBASE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction=DEBU
G
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG
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After you enable logging, log information is written to the following file:

WEBSPHERE_HOME/AppServer/logs/server_name/SystemOut.log

■ JBoss Application Server

To enable logging:

1. In the JBOSS_HOME/server/default/conf/log4j.xml file, locate the 
following lines:

<category name="ADAPTER.PSFTBASE">
   <priority value="log_level"/>
</category>

<category name="com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction">
   <priority value="log_level"/>
</category>

<category 
name="com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliation">
   <priority value="log_level"/>
</category>

2. In these lines, replace log_level with the log level that you want to set. For 
example:

<category name="ADAPTER.PSFTBASE">
   <priority value="DEBUG"/>
</category>

<category name="com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction">
   <priority value="DEBUG"/>
</category>

<category 
name="com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliation">
   <priority value="DEBUG"/>
</category>

After you enable logging, log information is written to the following file:

JBOSS_HOME/server/default/log/server.log

■ Oracle Application Server

To enable logging:

1. Add the following line in the 
OIM_HOME/xellerate/config/log.properties file:

log4j.logger.ADAPTER.PSFTBASE=log_level
log4j.logger.com.thortech.xl.Integration.peoplesoft.PeopleSoftUMAction=log_
level
log4j.logger.com.thortech.xl.Integration.peoplesoft.util.tcUtilReconciliati
on=log_level

2. In these lines, replace log_level with the log level that you want to set.

For example:

log4j.logger.ADAPTER.PSFTBASE=DEBUG
log4j.logger.com.thortech.xl.integration.peoplesoft.PeopleSoftUMAction=DEBU
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G
log4j.logger.com.thortech.xl.integration.peoplesoft.util.tcUtilReconciliati
on=DEBUG

After you enable logging, log information is written to the following file:

OAS_HOME/opmn/logs/default_group~home~default_group~1.log

Step 4: Importing the Connector XML File
To import the connector XML file into Oracle Identity Manager:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management.  A dialog box for opening 
files is displayed.

4. Locate and open the PSFTBaseConnector.xml file, which is in the 
OIM_HOME/xlclient directory. Details of the XML file are shown on the File 
Review page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Next. The Provide IT Resource Instance Data page for the PSFT Base 
Server IT resource is displayed.

8. Specify values for the parameters of the PSFT Base Server IT resource. The 
following table lists the values to be specified:

Parameter Description

Admin User ID of the PeopleSoft Enterprise Applications administrator

Default value: PS

AdminCredentials Password of the PeopleSoft Enterprise Applications administrator

ComponentInterfaceName Component interface used to load user data in PeopleSoft Enterprise 
Applications

Default value: USER_PROFILE

ServerName IP address or computer name of the PeopleSoft Enterprise Applications 
server

Note: The IP address must be followed by the port number on which 
PeopleSoft Internet Architecture is running. For example, ServerName = 
172.21.109.48:90

ServerPort Port at which the PeopleSoft Enterprise Applications server is listening

Default value: 8000

IsSecure Specify whether or not the SSL feature is enabled

The value can be YES or NO. The default value is NO.

Note: It is recommended that you enable SSL to secure communication with 
the target system.
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9. Click Next. The Provide IT Resource Instance Data page for a new instance of the 
PSFT Base Server IT resource type is displayed.

10. Click Skip to specify that you do not want to define another IT resource. The 
Confirmation page is displayed.

11. Click View Selections.

The contents of the XML file are displayed on the Import page. You may see a 
cross-shaped icon along with some nodes. These nodes represent Oracle Identity 
Manager entities that are redundant. Before you import the connector XML file, 
you must remove these entities by right-clicking each node and then selecting 
Remove.

12. Click Import. The connector file is imported into Oracle Identity Manager.

After you import the connector XML file, proceed to the next chapter.

SymbolicId Specifies the AccessId associated with the user profile

The AccessId specifies whether or not the user has sufficient privileges on the 
PeopleSoft Enterprise Applications database. 

Sample value: PS89

NumberOfRetries Use this parameter to specify the number of times Oracle Identity Manager 
must try connecting to the target system before the 
InvocationTargetException is thrown.

Default value: 2

Note: The timeout feature is enabled only for full reconciliation and 
provisioning. It is not applied during incremental reconciliation. 

DelayBetweenRetries Use this parameter to specify the time difference between consecutive retries 
(in milliseconds).

Default value: 20000

IndexOfLastReconciledReco
rd

This parameter stores the index of last successful reconciled record. This 
parameter is applicable only for full reconciliation. Refer to the "Configuring 
the IndexOfLastReconciledRecord Parameter" section on page 3-22 for more 
information about this parameter

Default value: -1

See Also: If you want to define another IT resource, then refer to 
Oracle Identity Manager Administrative and User Console Guide for 
instructions.

Note: The default name of the IT resource provided in the connector 
xml file is PSFT Base Server. This name is hardcoded in the 
incremental reconciliation code for PeopleTools 8.22. This IT resource 
name must not be changed for incremental reconciliation to be run 
successfully.

Parameter Description
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3
Configuring the Target System and Oracle

Identity Manager

This chapter discusses the following topics:

■ Configuring the Target System

■ Configuring Oracle Identity Manager

Configuring the Target System
This section discusses the following topics:

■ Configuring the Target System for Full Reconciliation

■ Configuring the Target System for Incremental Reconciliation

■ Configuring the Target System for Provisioning

Configuring the Target System for Full Reconciliation
As described in Chapter 1, "About the Connector", full reconciliation is used to 
reconcile all the data in the target system into Oracle Identity Manager. The 
PeopleCode that is activated extracts the required user account information by using 
the USERMAINT component.

Configuring the target system for full reconciliation involves preparing the flat file for 
full reconciliation by performing the following procedures:

■ Creating the Application Engine Program

You have to create the Application Engine program only once when you are 
perform full reconciliation for the first time.

■ Running the Application Engine Program

You must run the Application Engine program each time you want to perform full 
reconciliation.

Note: These sections provide both conceptual and procedural 
information about configuring the connector. Oracle recommends that 
you read the conceptual information before you perform the 
procedures.
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Creating the Application Engine Program
The Application Engine program populates the flat file used to perform full 
reconciliation with user account information that requires reconciliation. To create the 
Application Engine program:

1. To open Application Designer in 2-tier mode, click Start, Programs, Peoplesoft8.x, 
and then Application Designer.

2. Select New from the File menu.

3. In the New Definition dialog box, select App Engine Program from the Definition 
list.

4. On the App Engine Program page, a plus sign (+) is displayed before the MAIN 
section in the Application Engine program under which there may be multiple 
steps. In each step, there may be some PeopleCode to be run. Click the plus sign 
(+). A step titled Step01 is added to MAIN.

5. Rename Step01 to Currency.

6. On the App Engine Program page, select Action from the Insert menu. An action 
is added to the Currency step.

7. Select PeopleCode from the list for the new action.

8. Click Save from the File menu to save the Application Engine program with the 
name BLKPRCS_USER.

9. Double-click the PeopleCode action. A new PeopleCode window is displayed.

10. In the PeopleCode window, copy the code from the   
OIM_HOME/xellerate/Scripts/CurrencyCode.txt file.

11. In the code that you copy, retain the file name (CurrencyCode.txt) but change 
the path to a directory location on the PeopleSoft server as follows:

&DataFile = GetFile("path where you want to generate the comma-separated flat 
file\CurrencyCode.txt", "w", %FilePath_Absolute);
&LOGFile = GetFile("path where you want to generate the comma-separated flat 
file\CurrencyCode.txt", "w", "a", %FilePath_Absolute);

For example:

&DataFile = GetFile("C:\PSFT_849_LOOKUPS\CurrencyCode.txt", "w", 
%FilePath_Absolute);
&LOGFile = GetFile("C:\PSFT_849_LOOKUPS\CurrencyCodelook_up.log", "w", "a", 
%FilePath_Absolute);

12. Save the PeopleCode action, and close the window.

13. On the App Engine Program page, select the MAIN section and then select 
Step/Action from the Insert menu.

14. Repeat Steps 5 through 12 to create the remaining steps, which are listed in the 
following table:

Step Name File Containing the Required PeopleCode

language LanguageCode.txt

emplid EmployeeId.txt

userrole (PeopleTools 8.22 only) UserRoles.txt

permiss PermissionList.txt
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15. Save the Application Engine program.

Running the Application Engine Program
The procedure to run the Application Engine program depends on the release of 
PeopleTools that you are using:

■ Running the Application Engine Program on PeopleTools 8.22

■ Running the Application Engine Program on PeopleTools 8.45 Through 8.48

Running the Application Engine Program on PeopleTools 8.22
To run the Application Engine program on PeopleTools 8.22:

1. Log in to PeopleSoft Internet Architecture.

2. Click People Tools, Process Scheduler Manager, Use, and Process Definitions.

3. On the Process Definitions page, click Add a New value.

4. Select Application Engine from the Process Type list.

5. Enter the name of the Application Engine program as the process name, 
BLKPRCS_USER. 

6. Click Add. 

7. Select the Application Engine program from the search results that are displayed 
when you click Add.

8. On the Process Definition Options tab, specify the following values:

■ Run Location: Server

■ Server Name: PSNT

■ Component: PRCSMULTI

■ Process Groups: ALLPANLS

9. Click Save.

10. Return to the home page.

11. Click PeopleTools, Process Scheduler Manager, Process, and Sample Processes.

12. On the Sample Processes page, click Add a New value.

13. Specify a run control ID, and then click Add.

14. Click Run.

EmailType (PeopleTools 8.45 through 
8.48 only)

EmailType.txt

addemp AddEmp.txt

Note: A run control ID is used as a key for records that contain the 
parameters required by a process at run time. If the parameters are 
stored in a table that the process can query using the run control ID 
and user ID, then the process can run without user intervention.

Step Name File Containing the Required PeopleCode
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15. On the Process Scheduler Request page, specify the server name.

16. Select the Application Engine program name, and then click OK.

17. Click Process Monitor to verify the status of the process.

After the process status changes to Success, the comma-separated flat file is 
created at a location specified in the code that you copy from the AddEmp.txt file.

Running the Application Engine Program on PeopleTools 8.45 Through 8.48

To run the Application Engine program on PeopleTools 8.45 through 8.48:

1. To open Application Designer in 2-tier mode, click Start, Programs, Peoplesoft8.x, 
and then Application Designer.

2. Specify the connection type, user ID, and password.

3. To open the Application Engine program that you created:

a. From the File menu, select Open and then select Application Engine Program 
from the Object Type list.

b. Select BLKPRCS_USER, and then click Open.

4. Click the RUN PROGRAM control on the toolbar below the menu bar. The 
comma-separated flat file containing user records is created at the location 
specified in the code that you copy from the AddEmp.txt file.

Configuring the Target System for Incremental Reconciliation
Configuring the target system for incremental reconciliation involves creating 
messages and message channels, publishing messages by writing PeopleCode that is 
used to populate and send messages from PeopleSoft Integration Broker to other 
systems, and configuring Integration Broker.

A message is the physical container for the XML data that is sent from PeopleSoft 
Enterprise Applications. Message definitions provide the physical description of data 
that is sent from PeopleSoft Enterprise Applications. This data includes fields, field 
types, and field lengths. A message channel is used to carry messages. It is a 
mechanism for structuring data into logical groups. Each message can belong to only 
one message channel.

After messages are created and associated with their respective message channels, you 
must publish the messages, which involves writing the PeopleCode in the application 
designer. This is because PeopleSoft Integration Broker and Oracle Identity Manager 
communicate through the exchange of XML messages and a message can only be 
started by using specific instructions in the PeopleCode.

Note: For the Application Engine program to run in 2-tier mode, the 
database client must be installed on the server used for accessing the 
application designer. To switch to the 2-tier mode, you select 
Connection Type as the database on the PeopleSoft sign-on screen. 

Note: In PeopleSoft Application version 9.0, queues replace message 
channels.
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Setting the PeopleSoft Integration Broker gateway is mandatory when you configure 
PeopleSoft Integration Broker. To subscribe to XML data, Oracle Identity Manager can 
accept and process XML messages posted by PeopleSoft by using PeopleSoft 
connectors located in the PeopleSoft Integration Broker gateway. These connectors are 
Java programs that are controlled by the Integration Broker gateway and, in turn, 
control the location of the XML files.

This gateway is a program that runs on the PeopleSoft Web server. It acts as a physical 
hub between PeopleSoft and other PeopleSoft applications (or third-party systems, 
such as Oracle Identity Manager). The gateway manages the receipt and delivery of 
messages passed among systems through PeopleSoft Integration Broker.

To configure the target system for incremental reconciliation, you must perform the 
following procedures:

1. Creating the Message Channel

2. Creating the Message

3. Publishing the Message

4. Configuring PeopleSoft Integration Broker

Creating the Message Channel
The procedure to create a message channel varies depending on the version of 
PeopleTools that you are using:

■ Creating the Message Channel on PeopleTools 8.22

■ Creating the Message Channel on PeopleTools 8.45 Through 8.47

■ Creating the Queue on PeopleTools 8.48

Creating the Message Channel on PeopleTools 8.22  To create the message channel on 
PeopleTools 8.22: 

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

2. Select New from the File menu.

3. In the New Definition dialog box, select Message Channel, and then click OK.

4. Save the new message channel as USR_MGMT_CH.

5. Select Object Properties from the File menu.

6. In the Message Channel Properties dialog box, select the Run option, and then 
select Archive Messages.

7. Click OK, and then save the message.

Note: The procedures to create messages, message channels, and 
publishing messages depend on the version of the target system being 
used. The procedure to configure PeopleSoft Integration Broker 
depends on the version of PeopleTools being used.

Note: You must use an administrator account to perform the 
following procedures.
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Creating the Message Channel on PeopleTools 8.45 Through 8.47  To create the message 
channel on PeopleTools 8.45 Through 8.47: 

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

2. Select New from the File menu.

3. In the New Definition dialog box, select Message Channel, and then click OK.

4. Save the new message channel as USR_MGMT_CH.

5. Select Object Properties from the File menu.

6. In the Message Channel Properties dialog box, select the Use tab, select the Run 
option, and then select the Archive Messages check box.

7. Click OK, and then save the message channel.

Creating the Queue on PeopleTools 8.48  To create the queue on PeopleTools 8.48:

1. In the PeopleSoft Internet Architecture window, expand People Tools, Integration 
Broker, and Integration Setup, and then click Queue.

2. On the Add a New Value tab, enter the queue name, for example, 
PSFT_UM_QUEUE, and then click Add.

3. On the Queue Definition tab, select the archive check box.

4. Select Run from the Queue Status list.

5. Click Save to save the changes.

Creating the Message
The procedure to create a message varies depending on the version of the PeopleTools 
that you are using:

■ Creating the Message on PeopleTools 8.22

■ Creating the Message on PeopleTools 8.45 Through 8.47

■ Creating the Message on PeopleTools 8.48

Creating the Message on PeopleTools 8.22  To create the message on PeopleTools 8.22:

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed.

2. Select New from the File menu. 

3. In the New Definition dialog box, select Message from the list, and then click OK.

4. Select Object Properties from the File menu.

5. In the Message Properties dialog box, click the Use tab.

6. On the Use tab, select the USR_MGMT_CH message channel from the list and 
then select the version of the message that you create from the Version list. By 
doing this, you associate the message with the message channel created in the 
"Creating the Message Channel on PeopleTools 8.22" section on page 3-5.

7. Select Active to make the message an active message, and then click OK.

8. Right-click VERSION_1, and select the Insert Child Record option.

9. In the Insert Record window, enter PSOPRDEFN in the Name field, click Insert, and 
then click Close.
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10. Click PSOPRDEFN under VERSION_1. All the fields that constitute the 
PSOPRDEFN records are displayed.

By default, all the fields are selected. Deselect the check boxes for the fields that 
are not required for the message XML file to be generated.

For the USR_MGMT_MSG message, deselect the following fields from the 
PSOPRDEFN record:

■ VERSION

■ CLASSCOUNT

■ OPERPSWD

■ ENCRYPTED

■ LASTPSWDCHAN

■ ACCTLOCK

■ LASTUPDDTTM

■ LASTUPDOPRID

■ FAILEDLOGINS

11. Repeat Steps 8 through 10 for the PSROLEUSER_VW record. Deselect the following 
fields for this record:

■ OPRID

■ DYNAMIC_SW

12. Save the message as USR_MGMT_MSG.

Creating the Message on PeopleTools 8.45 Through 8.47  To create the message on 
PeopleTools 8.45 Through 8.47:

1. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed.

2. Select New from the File menu.

Note: PSOPRDEFN is a record defined in the 
OIM_HOME/xellerate/test/cbrecon/USR_MGMT_MSG.xml file. 
Refer to this file for information about the fields that comprise the 
PSOPRDEFN record.

Note: Do not delete the fields from the PSOPRDEFN record. You just 
need to deselect the check boxes for the fields in the message 
definition.

Note: PSROLEUSER_VW is the second record defined in the 
OIM_HOME/xellerate/test/cbrecon/USR_MGMT_MSG.xml file.
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3. In the New Definition dialog box, select Message from the list and then click OK.

4. Select Object Properties from the File menu. The Message Properties dialog box is 
displayed.

5. In the Message Properties dialog box, click the Use tab.

6. On the Use tab, select the USR_MGMT_CH message channel and the version of 
the message that you create in Step 2 of this procedure. By doing this, you 
associate the message with the message channel created in the "Creating the 
Message Channel on PeopleTools 8.45 Through 8.47" section on page 3-6.

7. Select Active to make the message an active message and then click OK to close 
the dialog box.

8. Save the message as USR_MGMT_MSG.

You can also save this message with a name of your choice. If you do so, then you 
must make the same change in the code that you copy from the 
UserMgmtCBRecon_8.45-8.47.txt file while performing the procedure 
described in the "Publishing the Message" section on page 3-8.

Creating the Message on PeopleTools 8.48  To create the message on PeopleTools 8.48:

1. In the PeopleSoft Internet Architecture window, expand People Tools, Integration 
Broker, and Integration Setup, and then click Message.

2. On the Add a New Value tab, enter the message name, for example, 
USR_MGMT_MSG. In addition, enter the version in the Version field. The valid 
values for this field are version_1 or v1.

3. Click Add.

4. On the Message Definition tab, select Nonrowset-based as the message type.

5. Click Save to save the changes.

Publishing the Message
To publish the message on PeopleTools 8.22 through 8.48:

1. Click Start, Programs, Peoplesoft8.x, and then Application Designer. The 
Application Designer window is displayed in 2-tier mode.

2. Select Open from the File menu. The Open Definition dialog box is displayed.

Note: To run the Application Designer in 2-tier mode, you must have 
the database client, which is the client of the database that PeopleSoft 
is using, installed on the server. In addition, you must select the 
appropriate database type from the Connection Type field (for 
example, Oracle Database) while providing sign-on information in the 
PeopleSoft Application Designer Signon window.

Note: To run the Application Designer in 2-tier mode, you must have 
the database client, which is the client of the database that PeopleSoft 
is using, installed on the server. In addition, you must select the 
appropriate database type from the Connection Type field (for 
example, Oracle Database) while providing sign-on information in the 
PeopleSoft Application Designer Signon window.
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3. Select Component from the Definition list, enter USERMAINT in the Name 
Selection Criteria field, and then click Enter. All component names starting with 
the text USERMAINT are displayed.

4. Select USERMAINT from the list, and then click Open. The details of the 
USERMAINT component are displayed.

5. Click the Structure tab, right-click USERMAINT, and then select View 
PeopleCode. The PeopleCode for the USERMAINT component is displayed.

6. Select the SavePostChange event from the list in the upper-right corner of the 
window. The PeopleCode for this event is displayed.

7. Copy the code given in the following file immediately after the import definitions 
in the PeopleCode for the SavePostChange event:

For PeopleTools 8.22:

OIM_HOME/xellerate/Scripts/UserMgmtCBRecon.txt

For PeopleTools 8.45 through 8.47:

OIM_HOME/xellerate/Scripts/UserMgmtCBRecon_8.45-8.47.txt

For PeopleTools 8.48:

OIM_HOME/xellerate/Scripts/UserMgmtCBRecon_8.48.txt

8. If you are using PeopleTools 8.22, then select Save from the File menu to save the 
changes to the USERMAINT component.

If you are using PeopleTools 8.45 through 8.48, then:

a. Add the following function call at the end of the PeopleCode for the 
SavePostChange event:

/**********************************************************************/
/* Calling the GENERATEUSER function to generate the 
USR_MGMT_MSG message*/
/**********************************************************************/
If Len(%CompIntfcName) = 0 Then 
Local string &OPID;
&OPID = PSOPRDEFN.OPRID;
&s_ipadd = %Request.ServerName;
&n_port = %Request.ServerPort;
GENERATEUSR(&OPID);
End-If;

b. Select Save from the File menu to save the changes to the USERMAINT 
component.

Note: While creating the message by following the procedures 
described in the "Creating the Message" section on page 3-6, if you 
change the name of the message to something other than 
USR_MGMT_MSG, then you must use the same name in the code that 
you copy.

Note: Perform this step only after you copy the code from the text 
file.
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Configuring PeopleSoft Integration Broker
The procedure to configure PeopleSoft Integration Broker depends on the release of 
PeopleTools that you are using.

The following section explains the procedure to configure PeopleSoft Integration 
Broker on PeopleTools 8.22:

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.22

The following sections explain the procedures to configure PeopleSoft Integration 
Broker on PeopleTools 8.45 through 8.47 and PeopleTools 8.48:

■ Configuring PeopleSoft Integration Broker Gateway on PeopleTools 8.45 Through 
8.48

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.45 Through 8.47

■ Configuring PeopleSoft Integration Broker on PeopleTools 8.48

Configuring PeopleSoft Integration Broker on PeopleTools 8.22  To configure PeopleSoft 
Integration Broker on PeopleTools 8.22:

1. To create the USR_MGMT_NODE remote node:

a. In the Application Designer, select New from the File menu.

b. In the New Definition dialog box, select Message Node from the list, and then 
click OK.

c. Right-click anywhere in the white space, and then select Insert Location. The 
Location dialog box is displayed.

d. Enter the URL for the PeopleSoft Integration Broker gateway in the following 
format:

http://hostname:port/servlets/gateway

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

e. Select Object Properties from the File menu.

f. In the Message Node Properties dialog box, select the Use tab. Ensure that 
Local Node is not selected.

g. Save the remote node as USR_MGMT_NODE.

2. To configure the USR_MGMT_MSGCH message channel:

Note: While configuring PeopleSoft Integration Broker, you perform 
some of the procedures in PeopleSoft Internet Architecture and some 
in the Application Designer. For example, for PeopleTools 8.22 and 
PeopleTools 8.45 through 8.47, some of the configuration steps must 
be performed in PeopleSoft Internet Architecture and some in the 
Application Designer. For PeopleTools 8.48, all of the configuration 
steps must be performed in PeopleSoft Internet Architecture.

Note: Configuring the PeopleSoft Integration Broker gateway is a 
part of the procedure to configure the PeopleSoft Integration Broker 
on PeopleTools 8.22.
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a. From the File menu, select Open and then click Message Channel.

b. To open the USR_MGMT_MSGCH message channel, select 
USR_MGMT_MSGCH.

c. Click the Routing Rules tab.

d. Right-click anywhere in the white space, and then select Insert Message 
Node.

e. In the Insert Message Node dialog box, select the USR_MGMT_NODE  
message node, and then click Insert.

f. Close the dialog box.

g. Right-click the message node displayed on the Routing Rules tab. 

h. Point to Routing Direction, and then select Publish To.

i. Save the message channel.

3. To configure the PeopleSoft Integration Broker gateway so that messages can be 
sent through the gateway to Oracle Identity Manager:

a. In a Web browser, use a URL with the following format to open the Handler 
Directory page (configuration window for the PeopleSoft Integration Broker 
gateway):

http://hostname:port/servlets/gateway.administration

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

b. Click Add Handler.

c. On the Add Handler page, enter the full name of the Simple File Handler 
class, psft.pt8.filehandler.SimpleFileHandler.

d. Click Save.

e. To load the handler, on the Handler Directory page, click Load.

After the handler is loaded, the "Loaded successfully" message is displayed in 
the Status column.

f. Click Configure.

g. Click Add a file handler node.

h. In the Node Name field on the Add File Handler Node page, enter the name 
of the message node that you create, USR_MGMT_NODE.

i. Specify the output directory in which the published messages are to be stored.

j. Select Include Header.

k. Click Save.

4. XML messages are generated by the PeopleTools 8.22 Simple File Handler. To 
publish these messages to the connector, create a Microsoft Windows scheduled 

Note: The Simple File Handler mentioned in this procedure is a 
utility in PeopleTools 8.22 that can receive messages published by a 
PeopleSoft node and write these messages to a file that can be used by 
third-party systems.
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task as follows. You must create the scheduled task on the computer on which the 
PeopleSoft Web server is running.

a. Copy the xliMsgPublisher.jar and publish.bat files from the 
OIM_HOME/xellerate/lib/MsgPublisher directory to a directory on the  
PeopleSoft Enterprise Applications server.

b. Use a text editor to open the publish.bat file, and then make the following 
changes in the file:

i. Change the value of the JAVA_HOME variable so that it points to the JDK 
installation directory on the computer on which the PeopleSoft Web server is 
running.

ii.  Specify the following values in the Java command given at the end of the 
file:

- PeopleSoft_listener_servlet_URL: This is the URL of the servlet 
that listens for reconciliation events generated using PeopleSoft Application 
Messaging.

- Output_directory_for_XML_messages: This is the PeopleSoft Web 
server directory in which you want published messages to be stored. You have 
already specified the output directory while performing Step 3.i of this 
procedure.

- XML_message_name: This is the message name created while configuring 
the target system. Refer to the "Creating the Message" section on page 3-6 for 
more information.

- console_log_file_path: This is the full path and the name of the 
directory in which the log file must be generated.

The command is in the following format:

java com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"PeopleSoft_listener_servlet_URL" "Output_directory_for_XML_messages" 
XML_message_name >> console_log_file_path

For example:

java com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://hostname:port/peopleSoftUserMgmt/do/peopleSoftAction" 
"C:/test/file" PSFT_XELLERATE_MSG >> c:/test/consolelog.log

In the PeopleSoft listener servlet URL specified in this example, hostname is 
the IP address or host name of the application server on which Oracle Identity 
Manager is running and port is the HTTP port at which the application 
server listens for incoming messages.

Note: The Microsoft Windows scheduled task calls a Java program 
that communicates with a servlet deployed on the Oracle Identity 
Manager server. The servlet parses the message and sends 
reconciliation events to Oracle Identity Manager.

The servlet sends a return code based on the status of the 
reconciliation event. If the reconciliation event is successfully sent, 
then the message file is deleted or archived. Otherwise, the message 
file is left unchanged. The next time the scheduled task is run, another 
attempt is made to send the message.
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c. Save and close the batch file.

d. On the computer on which the PeopleSoft Web server is running, click Start, 
Settings, and Control Open.

e. Double-click Scheduled Tasks.

f. Click Add Schedule Task, and then click Next.

g. Click Browse, and then select the publish.bat file from the directory in 
which you save it.

h. Select Daily, click Next, and then click Next again.

i. Enter the user ID and password for the scheduled task to run.

j. Select Open Advance properties.

k. Click Finish.

l. On the Schedule tab, click Advanced.

m. Select Repeat Task.

n. Select the frequency at which you want the task to run.

o. Click OK, and then click OK again to close the window.

Configuring PeopleSoft Integration Broker Gateway on PeopleTools 8.45 Through 8.48  To 
configure the PeopleSoft Integration Broker gateway on PeopleTools 8.45 through 8.48:

1. Open a Web browser and enter the URL for PeopleSoft Internet Architecture.

The URL for PeopleSoft Internet Architecture is in the following format:

http://servername/psp/ps/Databasename/?cmd=login

For example:

http://psftserver.example.com/psp//ps/TestDB/?cmd=login

2. To display the Gateway component details, expand PeopleTools, Integration 
Broker, Configuration, and then Gateways. The Gateway component details are 
displayed.

3. Enter LOCAL in the Integration Gateway ID field, and then click Search. The 
LOCAL gateway is a default gateway that is created when you install PeopleSoft 
Internet Architecture.

4. Ensure that the IP address specified in the URL of the PeopleSoft listening 
connector is the IP address of the computer on which PeopleSoft Enterprise 
Applications is installed. The URL of the PeopleSoft listening connector is in the 
following format:

http://computer_name_of_the_PeopleSoft_Web_server/IP_address:port/PSIGW/PeopleS
oftListeningConnector

For example:

http://10.121.16.42:80/PSIGW/PeopleSoftListeningConnector

5. To load all target connectors that are registered with the LOCAL gateway, click 
Load Gateway Connectors.

6. Click Save.

7. Click Ping Gateway to check if the gateway component is active.
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Configuring PeopleSoft Integration Broker on PeopleTools 8.45 Through 8.47  To configure 
PeopleSoft Integration Broker on PeopleTools 8.45 through 8.47:

To create the USR_MGMT_NODE node to serve as the remote node:

1. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and Node Definitions.

2. Click the Add a New Value tab.

3. On the Add a New Value tab, enter USR_MGMT_NODE as the node name and then 
click Add.

4. On the Node Definition tab, enter a description for the node in the Description 
field.

5. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

6. On the Connectors tab, enter the following information and then perform a 
lookup:

Gateway ID: LOCAL

Connector ID: HTTPTARGET

7. On the Properties subpage in the Connectors tab, enter the following information:

Property ID: HTTPTARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is supposed to receive 
the XML message. This URL must be in the following format:

http:/computer_name_of_the_Oracle_Identity_Manager_server/IP_address:port/peopl
eSoftUserMgmt/do/peopleSoftAction

For example:

http://10.121.16.42:8080/peopleSoftUserMgmt/do/peopleSoftAction

8. Click Ping Node to check if a connection is established with the specified IP 
address.

9. On the Transactions tab, click Add Transaction. The Add Transaction dialog box is 
displayed.

10. Enter the following details to define a new transaction:

Transaction Type: Outbound Asynchronous

Request Message: USR_MGMT_MSG

Request Message Version: VERSION_1

11. Click Add.

12. To keep the status as active, select Active.

13. Click Save to save the changes.

To secure the USR_MGMT_MSGCH message channel:

1. In PeopleSoft Internet Architecture, expand PeopleTools, Security, Permission & 
Roles, and Permission Lists.

2. Select AEAE1000. The AEAE1000 permission list is displayed.
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3. Select the Message Monitor tab, and then click the plus sign (+) to add a channel 
name.

4. Specify USR_MGMT_MSGCH as the channel name, and select FULL as the access 
level.

5. Click Save.

To verify that the USR_MGMT_MSGCH message channel is in running mode:

1. Expand PeopleTools, Integration Broker, Monitor Integration, and Monitor 
Message.

2. Click the Channel Status tab.

3. Verify that the USR_MGMT_MSGCH message channel is running. If it is paused, then 
click Run.

Configuring PeopleSoft Integration Broker on PeopleTools 8.48  To configure PeopleSoft 
Integration Broker on PeopleTools 8.48:

1. Create a remote node by performing the following steps:

a. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and then click Nodes.

b. On the Add a New Value tab, enter the node name, for example, 
USR_MGMT_NODE, and then click Add.

c. On the Node Definition tab, enter a description for the node in the 
Description field. In addition, enter PS in the Default User ID field.

d. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

e. On the Connectors tab, enter the following information:

Gateway ID: LOCAL

Connector ID: HTTPTARGET

f. Click Ping Node to check if a connection is established with the specified IP 
address.

g. On the Properties subpage in the Connectors tab, enter the following 
information:

Property ID: PRIMARYURL

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is supposed to 
receive the XML message. This URL must be in the following format:

http://computer_name_of_OIM_server/IP 
address:port/peopleSoftUserMgmt/do/peopleSoftAction

For example:

http://10.121.16.42:8080/peopleSoftUserMgmt/do/peopleSoftAction

h. Click Save to save the changes.

2. Create a service by performing the following steps:

a. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and then click Service.
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b. On the Add a New Value tab, enter the service name, for example, 
PSFT_UM_SERVICE, and then click Add.

c. On the Service Definition tab, enter a description for the service in the 
Description field.

d. Click Save to save the changes.

3. Create a service operation by performing the following steps:

a. In PeopleSoft Internet Architecture, expand PeopleTools, Integration Broker, 
Integration Setup, and then click Service Operation.

b. On the Add a New Value tab, enter the service name for which you are 
creating the service operation. In addition, enter the service operation name. 
The name of the service operation must be the same as that of the message you 
created in Step 2 of the "Creating the Message on PeopleTools 8.48" section on 
page 3-8, for example, USR_MGMT_MSG.

c. From the Operation type list, select Asynchronous-Oneway, and then click 
Add.

d. On the General tab of the Service Operation Definition page, enter a 
description for the Operation type in the Operation Description field. In 
addition, enter USR_MGMT_MSG.V1 in the Message.Version field and 
PSFT_UM_QUEUE in the Queue Name field.

e. Click Save to save the changes.

f. On the Routing tab, enter PSFT_UM_ROUTING as the routing name and then 
click Add.

g. On the Routing Definition tab, enter PSFT_HR in the Sender Node field and 
PSFT_UM_NODE in the Receiver Node field.

h. Click Save to save the changes.

Before the XML messages are sent from the target system to Oracle Identity 
Manager, you must verify if the PeopleSoft node is running. You can do so by 
clicking the Ping Node button in the Connectors tab. To access the Connectors tab, 
click PeopleTools, Integration Broker, and then Nodes.

If the Oracle Identity Manager server is not running when a message is published, 
then the message is added to a queue. You can check the status of the message in 
the queue in the Message Instance tab. This tab lists all the published messages in 
queue. When you check the details of the particular message, you will find the 
status listed as Timeout or Error.

To publish a message in the queue to Oracle Identity Manager, resubmit the 
message when Oracle Identity Manager is running. See "Publishing the Message" 
on page 3-8 for more information.

If the status of the message is New or Started and it does not change to Timeout 
or Done, then you must restart the PeopleSoft application server after you restart 
the Oracle Identity Manager server.

Note: PSFT_HR is the default local node for PeopleSoft HCM 
applications. If you are using other PeopleSoft applications, verify the 
default local node by using the procedure described in Step 1a. For 
example, if you are using PeopleSoft CRM applications, then the 
default local node is PSFT_CR.
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Configuring the Target System for Provisioning
To configure the target system for provisioning, create the APIs for the component 
interface as follows:

1. To open the Application Designer, click Start and then select Programs, 
Peoplesoft8.x, and Application Designer.

2. On the Application Designer page, select Open from the File menu.

3. In the Open Definition dialog box, select Component Interface from the 
Definition list.

4. Enter USER_PROFILE in the Name field, and then press Enter.

All the component interfaces with names that start with USER_PROFILE are 
displayed in the Open Definition dialog box.

5. Select the USER_PROFILE entry, and then click Open.

6. Click Yes in the message that is displayed. The properties of the USER_PROFILE 
component interface are displayed.

7. In the window for the USER_PROFILE component interface, select PeopleSoft 
APIs from the Build menu. The Build PeopleSoft API Bindings dialog box is 
displayed.

8. In the Java Classes region, select Build.

9. From the Select APIs to Build list, select CompIntfc.CompIntfcPropertyInfo, 
CompIntfc.CompIntfcPropertyInfoCollection, and the APIs with names that start 
with CompIntfc.USER_PROFILE.

10. In the Target Directory field, specify the path of the directory in which you want 
the Java API classes to be created, and then click OK.

11. Ensure that the psjoa.jar file is set in the CLASSPATH environment variable. 
This file is in the PEOPLESOFT_HOME/PT8xx/web/PSJOA directory.

12. Compile the APIs from the target directory specified in the preceding step.

13. Bundle the compiled class files in a JAR named peoplesoft.jar as follows:

jar -cvf peoplesoft.jar PeopleSoft/Generated/CompIntfc/*.class

Configuring Oracle Identity Manager
This section discusses the following topics:

■ Configuring Reconciliation

■ Configuring Provisioning

Configuring Reconciliation
As mentioned earlier in this guide, reconciliation involves duplicating in Oracle 
Identity Manager new and modified user account information from PeopleSoft 
Enterprise Applications.

Note: The Unable to access pstools.properties message 
might be recorded in the server log during the provisioning operation. 
You can ignore this message.
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You can perform reconciliation in two modes: target resource and trusted source. 
Regardless of whether you configure target resource or trusted source reconciliation, 
you can configure full or incremental reconciliation for this connector by performing 
the procedures described in the following topics:

■ Configuring Full Reconciliation

■ Configuring Incremental Reconciliation

Perform the procedure described in the following section only if you want to configure 
trusted source reconciliation:

■ Configuring Trusted Source Reconciliation

Configuring Full Reconciliation
This section discusses the following topics:

■ Configuring the Reconciliation Scheduled Tasks

■ Configuring the IndexOfLastReconciledRecord Parameter

■ Adding Custom Attributes for Full Reconciliation

■ Limited Reconciliation

Configuring the Reconciliation Scheduled Tasks  

When you perform the procedure described in the "Step 4: Importing the Connector 
XML File" section on page 2-7, the scheduled tasks for lookup fields, trusted source, 
and target resource reconciliations are automatically created in Oracle Identity 
Manager. To perform a full reconciliation run, you must configure the scheduled task 
to reconcile the users in Oracle Identity Manager depending on the values that the 
user has specified in the scheduled task attributes.

To specify values for the attributes of the scheduled task, perform the following:

1. Open the Oracle Identity Manager Design Console.

2. Expand the Xellerate Administration folder.

3. Select Task Scheduler.

4. Click Find. The details of the predefined scheduled tasks are displayed on two 
different tabs. Select:

■ PSFT Base Non Trusted User Reconciliation for target resource 
reconciliation

Note: You can perform a full reconciliation run at any future date or 
time for the following specified intervals:

■ Daily

■ Weekly

■ Monthly

■ Yearly

■ Recurring intervals

Alternatively, you can configure a scheduled task attribute to run once 
on the specified date and time.
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■ PSFT Base Trusted User Reconciliation for trusted source 
reconciliation

5. Enter a number in the Max Retries field. This number represents the number of 
times Oracle Identity Manager must attempt to complete the task before assigning 
the FAILED status to the task.

6. Ensure that the Disabled and Stop Execution check boxes are not selected.

7. In the Start region, double-click the Start Time field. From the date-time editor 
that is displayed, select the date and time at which you want the task to run.

8. To set the task to run only once, select the Once option in the Interval region.

9. Provide values for the attributes of the scheduled task. Refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 3-19 for information 
about the values to be specified.

10. Click Save. The scheduled task is configured. The INACTIVE status is displayed in 
the Status field, because the task is not currently running. The task is run at the 
date and time that you specify in Step 7.

Specifying Values for the Scheduled Task Attributes
This section provides information about the values to be specified for the following 
scheduled tasks:

Lookup Fields Reconciliation Scheduled Task

You must specify values for the following attributes of the PSFT Base LookUp 
Reconciliation scheduled task:

Note:

■ Default attribute values are predefined in the connector XML file 
that you import. Specify values only for those attributes that you 
want to change.

■ Values (either default or user-defined) must be assigned to all the 
attributes. If even a single attribute value were left empty, then 
reconciliation would not be performed.

Attribute Description

ServerName Name of the IT resource

Default value: PSFT Base Server

LookupType The type of data that is being looked up in the target system.

The value can be any one of the following:

■ EmployeeId

■ LanguageCode

■ EmailTypes

■ CurrencyCode

■ PermissionList

■ Roles
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

User Reconciliation Scheduled Task

Depending on whether you want to implement target resource or trusted source 
reconciliation, you must specify values for the attributes of the user reconciliation 
scheduled tasks. The following table describes the attributes of the scheduled tasks.

FilePath Directory path on the Oracle Identity Manager server where the 
reconciliation lookup .txt file is stored

Sample value: 
C:/PSFTBase/LookupRecon/EmployeeIds.txt

LookupName Name of the lookup definition configured in Oracle Identity 
Manager

The value can be any one of the following:

■ Lookup.PSFTBase.EmployeeId

■ Lookup.PSFTBase.LanguageCode

■ Lookup.PSFTBase.EmailType

■ Lookup.PSFTBase.CurrencyCode

■ Lookup.PSFTBase.PermissionList

■ Lookup.PSFTBase.Roles

TargetSystem Name of the resource object

Default value: PSFTBase

Note:

■ You must specify values for either the target resource 
reconciliation scheduled task (PSFT Base Non Trusted User 
Reconciliation) or the trusted source reconciliation scheduled 
task (PSFT Base Trusted User Reconciliation). Do not 
specify values for the attributes of both scheduled tasks.

■ Attribute values are predefined in the connector XML file that you 
import. Specify values only for those attributes that you want to 
change.

■ Values (either default or user-defined) must be assigned to all the 
attributes. If even a single attribute value were left empty, then 
reconciliation would not be performed.

Attribute Description

MultiValueSeperator ## is the multivalue separator in the flat file that is used for full 
reconciliation

ServerName Name of the IT resource

Default value: PSFT Base Server

Attribute Description
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

IsTrusted Specifies whether or not reconciliation is to be carried out in 
trusted mode

Specify Yes for trusted source reconciliation.

Specify No for target resource reconciliation.

XellerateOrganization Default name of the Oracle Identity Manager organization is 
Xellerate Users

This value is used to create OIM User in trusted mode.

Note: This attribute is specific to the scheduled task for trusted 
source reconciliation.

FolderPath Directory path on the Oracle Identity Manager server where 
the comma-separated flat file is stored

Note: The folder path must contain only the flat file that is 
generated when you run the application engine, because the 
Task Scheduler searches for text files.

TargetSystem Name of the resource object

Default value: PSFTBase

NoOfRecordsToBeReconc
iled

Specifies the number of records to be reconciled

You must enter any integer value greater than zero. Refer to 
the "Specifying the Number of Records to Be Reconciled" 
section on page 3-22 for more information about this attribute.

Default value: All

Operator Specifies the operator that you want to apply to the target 
system attributes for which you specify a value other than 
nodata

This operator value can be AND or OR based on which the data 
is joined accordingly for any combination of the following 
fields: Lastname, Postal, DeptId.

During reconciliation, only those target system records that 
contain the specified combination of the Lastname, Postal, 
and DeptId fields are reconciled.

Note: This attribute is specific to the scheduled task for trusted 
source reconciliation

Default value: NODATA

UserID This is a filter attribute. Use this attribute to specify the login 
ID of the user whose records you want to reconcile.

Default value: NODATA

UserType This is a filter attribute. Use this attribute to specify the user 
type for which you want to reconcile records.

If you do not want to use this attribute, then specify NODATA.

Sample values: Customer, Person, Supplier

Note: This attribute is specific to the scheduled task for trusted 
source reconciliation

Default value: NODATA

Attribute Description
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Specifying the Number of Records to Be Reconciled
During a reconciliation run, all changes in the target system records are reconciled into 
Oracle Identity Manager. Depending on the number of records to be reconciled, this 
process may require a large amount of time. In addition, if the connection breaks 
during reconciliation, then the process would take longer to complete.

You can specify the number of records to be reconciled. To do this, you use the 
NoOfRecordsToBeReconciled scheduled task attribute.

You specify a value for the NoOfRecordsToBeReconciled attribute by following 
the instructions described in the "Specifying Values for the Scheduled Task Attributes" 
section on page 3-19.

Configuring the IndexOfLastReconciledRecord Parameter  

You specify a value for the IndexOfLastReconciledRecord IT resource parameter 
when you want to perform full reconciliation. At the start of the first full reconciliation 
run, the value of this parameter is -1. At the end of each subsequent full reconciliation 
run, this parameter stores the index number of the last record reconciled during the 
previous reconciliation run.

Whenever you want to perform a full reconciliation run, change the value of the 
IndexOfLastReconciledRecord parameter to -1. To change the value of this 
parameter:

1. Log in to the Oracle Identity Manager Design Console.

2. Expand Resource Management.

3. Double-click IT Resources.

4. Locate the PSFT Base Server IT resource.

5. Change the value of the IndexOfLastReconciledRecord parameter to -1.

Adding Custom Attributes for Full Reconciliation  

To add custom attributes for full reconciliation:

1. In PeopleSoft Application Designer:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Message from the Definition list, enter USR_MGMT_MSG in the Name 
Selection Criteria field, and then click Enter. The details of the 
USR_MGMT_MSG message are displayed.

c. Click the record to which you want to add custom attributes.

For example, if you want to add the Account lock attribute, ACCTLOCK in the 
PSOPRDEFN record, then click PSOPRDEFN under VERSION_1.

d. Select the check box for the required attribute, and then save the message.

Note: The procedure described in this section is the same for all 
certified versions of PeopleTools. If you do not want to add custom 
attributes for full reconciliation, then you can skip this section.

Note: Step 1 is mandatory if you are using PeopleTools 8.22.
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For example, select the ACCTLOCK check box.

2. Modify the header and the queries written in the application engine code 
(BLKPRCS_UM). For example, if you want to reconcile a new column with the 
name ACCTLOCK, then make the following changes in the application engine code:

Local String &acctlock

&hdr = 
"OPRID,OPRDEFNDESC,ALIAS,EMPLID,PRIEMAILID,LANGUAGE_CD,MULTILANG,CURRENCY_CD,OP
RCLASS,ROWSECCLASS,PRCSPRFLCLS,DEFAULTNAVHP,ROLES,EMAILIDS,USERTYPE, ACCTLOCK";

If the ACCTLOCK column exists in the PSOPRDEFN table, the SQL statement will be:

SQLExec("select ACCTLOCK from PSOPRDEFN where oprid =:1 ", &oprid, &acctlock);
   &data_row = &oprid | "," | &desc | "," | &alias | "," | &empid | "," | 
&email | "," | &lng_cd | "," | &multilang | "," | &currency | "," | &oprclass | 
"," | &rowsec | "," | &prcsprf | "," | &navhp | "," | &roles | "," | &othmail | 
"," | &type|" , "|&acctlock;

3. Open the process form located in the Development Tools folder of the Oracle 
Identity Manage Design Console.

4. Click Create New Version.

5. In the Create a New Version dialog box, specify the version name in the Label 
field. Save the changes, and then close the dialog box.

6. From the Current Version list, select the newly created version.

7. On the Additional Columns tab, click Add. Add a column corresponding to the 
new attribute in the User Defined process form, UD_PSFT_BAS. For the example 
described earlier, you can add the UD_PSFT_ACCTLOCK column.

8. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFTBase. For the example described earlier, you can add the 
Users.ACCTLOCK reconciliation field.

9. Modify the UD_PSFT_BAS process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the example 
described earlier, the mapping is as follows:

Users.ACCTLOCK=UD_PSFT_ACCTLOCK

In this example, ACCTLOCK is the reconciliation field and also the equivalent target 
system attribute. As a standard, the prefix "Users." is added at the start of all 
reconciliation field names.

Limited Reconciliation  

By default, all target system records that are added or modified after the previous 
reconciliation run are reconciled during the current reconciliation run. You can 
customize the reconciliation process by specifying the subset of newly added or 
modified records that must be reconciled. You implement this form of limited 
reconciliation by creating customized queries for reconciliation. You do this by 
creating filters for the reconciliation module.

For Target Resource Reconciliation: 

See Also: Oracle Identity Manager Design Console for more 
information about this step and the remaining steps of this procedure
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Creating a filter involves specifying a value for the UserID scheduled task attribute, 
which will be used in the SELECT query criteria to retrieve the records to be 
reconciled.

For instructions to specify values for the UserID scheduled task attribute, refer to the 
"Specifying Values for the Scheduled Task Attributes" section on page 3-19.

For Trusted Source Reconciliation:

Creating a filter involves specifying values for the UserID, UserType, and the 
Operator scheduled task attributes, which will be used in the SELECT query criteria 
to retrieve the records to be reconciled.

For instructions to specify values for the UserID, UserType, and Operator 
scheduled task attributes, refer to the "Specifying Values for the Scheduled Task 
Attributes" section on page 3-19.

Configuring Incremental Reconciliation

This section discusses the following topics:

■ Configuring the PeopleSoft Listener

■ Encrypting a New Oracle Identity Manager Password

■ Adding Custom Attributes for Incremental Reconciliation

■ Limited Reconciliation

Configuring the PeopleSoft Listener  This section describes how to configure the 
PeopleSoft listener. In the following procedure, OIM_HOME refers to the local Oracle 
Identity Manager installation directory.

To configure the PeopleSoft Listener:

1. Copy the OIM_HOME/cbrecon_webapp/lib/peopleSoftUserMgmt.war file 
into a temporary directory. Enter the following command in the command 
window to extract the contents of the peopleSoftUserMgmt.war file.

jar –xvf  peopleSoftUserMgmt.war

2. Edit the deployment.properties file. This file contains the message property 
that corresponds to the name of the XML message sent by PeopleSoft. The default 
value of this attribute is USR_MGMT_MSG. Obtain the actual value for this attribute 
from the PeopleSoft administrator, and replace the value in this file with the actual 
value.

3. If you are using PeopleTools 8.22, then you must modify the PSFTBase.Roles 
property in the attributemap.properties file as follows:

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data.

Note: All the files mentioned in the remaining steps of this 
procedure are extracted from the peopleSoftUserMgmt.war file.
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a. Search for the following line:

PSFTBase.Roles=//Transaction/PSROLEUSER_VW/ROLES

b. Replace it with the following line:

PSFTBase.Roles=//Transaction/PSROLEUSER_VW/ROLENAME

4. Edit the xlsession.properties file. This file contains the following Oracle 
Identity Manager connection parameters:

■ ObjectName: This is the name of the resource object in Oracle Identity 
Manager against which the reconciliation event is created. The default value is 
PSFTBase. For target resource reconciliation, you can change it to the name 
of any other resource object that you might have created.

■ Username: This is the user name for logging in to Oracle Identity Manager. 
The default value is xelsysadm.

■ Password: This is the password for logging in to Oracle Identity Manager. You 
must enter the encrypted value of the password.

5. Edit the xlclient.properties file. This file contains the following system 
properties that enable an API client to communicate with Oracle Identity Manager:

■ xl.homedir: This property specifies the Oracle Identity Manager client 
directory. Typically, the Oracle Identity Manager client directory is 
OIM_HOME/xlclient.

■ java.security.policy: This property specifies the path of the security policy file. 
Typically, this file is located in the OIM_HOME/xlclient/config directory.

■ java.security.auth.login.config: This property specifies the path of the 
authentication configuration file. Typically, this file is located in the 
OIM_HOME/xlclient/config directory.

Each application server uses a different authentication configuration file: 

IBM WebSphere: authws.conf

BEA WebLogic: authwl.conf

JBoss Application Server: auth.conf

Oracle Application Server: auth.conf

■ java.naming.provider.url: This property specifies the JNP URL of the 
application server. This URL is given in the 
<Discovery><CoreServer><java.naming.provider.url> tag of the 
OIM_HOME/xlclient/config/xlconfig.xml file. Each application server 
uses a different java.naming.provider.url:

Note: In the attributemap.properties file, the key part of each 
line is the text to the left of the equal (=) sign. You must ensure that the 
key part of the lines does not contain spaces. For example, PSFT 
Base.Roles, PSFTBase .Roles, PSFTBase. Roles are all 
invalid key values because they contain spaces.

See Also: The "Encrypting a New Oracle Identity Manager 
Password" section on page 3-29 for information about encrypting a 
plaintext password
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– WebLogic: t3://host:7001

– JBoss: jnp://host:1099

– WebSphere: corbaloc:iiop:host:2809

– Oracle Application Server: ormi://localhost:12401/Xellerate

6. Edit the following properties in the configureReconciliation.properties 
file:

■ reconciliationMode: This property can accept one of two possible values:

– If you want to perform trusted source reconciliation, then set this property 
to trusted.

– If you want to perform target resource reconciliation, then set this 
property to ntrusted (default).

■ Serverdateformat: This property specifies the date format that is used by the 
PeopleSoft server. You can select one of the following date formats:

– dd-mmm-yy

– ddmmyy

– yyddmm

– yymmdd

■ xellerateOrganization: This property specifies the name of the Oracle Identity 
Manager organization. The default value of this parameter is Xellerate 
Users. The value that you assign to this property must exist in Oracle 
Identity Manager.

■ nullDate: This property specifies the default value for a date field. The value 
is 2200/01/01 00:00:00 PST. This value is used if the date field is left 
empty.

■ PeoplesoftstartingYEAR:  This property specifies the year in two digits. If the 
number represented by these two digits (xx):

– Is greater than or equal to 50, then it is assumed that the year is 19xx.

– Is less than 50, then it is assumed that the year is 20xx.

 This specifies a range of 1950 to 2049 for the property.

■ XelServerDate: This property contains the date format that is used for the 
Oracle Identity Manager server.

Sample value: yyyy/mm/dd hh:MM:ss z

■ Filter: This property edits the value for filters, for example, OPRIDLIKE and 
UserType as required. The default value of this property is NO DATA. These 
values are used to configure incremental reconciliation.

7. Copy the following files from the OIM_HOME/xellerate/lib directory to the 
WEB-INF/lib directory:

Note: You must not change this date format.
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■ xlAPI.jar

■ xlAuthentication.jar

■ xlBackOfficeBeans.jar

■ xlBackofficeClient.jar

■ xlCache.jar

■ xlCrypto.jar

■ xlDataObjectBeans.jar (for IBM WebSphere Application Server, copy 
this file from the OIM_CLIENT/xlclient/lib directory) 

■ xlDataObjects.jar

■ xlLogger.jar

■ xlUtils.jar

■ xlVO.jar

■ xlAdapterUtilities.jar

Copy the following files from the OIM_HOME/xellerate/ext directory to the 
WEB-INF/lib directory:

■ oscache.jar

■ javagroups-all.jar

■ commons-collections.jar

■ commons-digester.jar

■ commons-logging.jar

■ commons-validator.jar

■ jdbcpool-0.99.jar

■ log4j-1.2.8.jar

■ struts.jar

■ xalan.jar

■ xerces.jar

■ xercesImpl.jar

■ xlRemoteManager.jar

■ xlScheduler.jar

Copy the following files from the OIM_HOME/xellerate/ThirdParty directory 
to the WEB-INF/lib directory:

■ peoplesoft.jar

■ psjoa.jar

Note: Before you copy these files from the 
OIM_HOME/xellerate/lib directory, check if these files exist in the 
WEB-INF/lib directory. If these files exist, then delete them from the 
WEB-INF/lib directory before copying from the 
OIM_HOME/xellerate/lib directory.
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8. Delete the peopleSoftUserMgmt.war file from the temporary directory into 
which you extract it, and then use the following command to re-create the file:

jar –cvf  peopleSoftUserMgmt.war

9. Ensure that the old version of the peopleSoftUserMgmt.war file is removed 
from the application server (BEA WebLogic, IBM WebSphere, JBoss Application 
Server, or Oracle Application Server) deployment directory.

10. Deploy the newly created peopleSoftUserMgmt.war file in the deployment 
directory of the application server as follows:

BEA WebLogic:

1. Copy the war file to 
BEA_HOME/user_projects/OIM_DOMAIN/applications

in which:

BEA_HOME is the BEA WebLogic installed directory.

OIM_DOMAIN is the domain on which Oracle Identity Manager is installed.

2. Restart the WebLogic server.

IBM WebSphere:

1. Log in to the WebSphere Admin console using a valid username and 
password.

2. Expand the Applications node.

3. Click Install New Application.

4. Locate the WAR file by using the Browse button.

5. Specify the Context root as peopleSoftUserMgmt.

6. Click Next.

7. Accept the default setting in the next page and click Next.

8. On the Application Security Warnings page, click Continue.

9. Click Next.

10. On the Install New Application page, specify the application name as 
peopleSoftUserMgmt.

11. Click Next.

12. On the subsequent pages, click Next until the Finish button is displayed.

13. Click Finish.

14. Select the Save to Master Configuration link for saving the configurations in 
Websphere.

15. Click Save.

16. Click Enterprise Applications. On the Enterprise Applications page, the 
peopleSoftUserMgmt check box is displayed.

See Also: The "Step 2: Copying the Connector Files and External 
Code Files" section on page 2-2 for information about the 
peoplesoft.jar and psjoa.jar files
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17. Select the peopleSoftUserMgmt check box and click Start to start the 
application. 

JBoss Application Server:

1. Copy the modified war file to the JBOSS_HOME\server\default\deploy 
directory.

2. Restart the JBoss application server.

Oracle Application Server:

1. Log in to the Oracle Application Server using a valid username and password.

2. Select the name of the instance on which the Oracle Identity Manager server is 
running.

3. Select the Applications tab.

4. Click Deploy.

5. Select the WAR file by clicking Browse.

6. Click Next.

7. Specify the application name as peopleSoftUserMgmt.

8. Click Next.

9. To accept the default deployment settings, click Deploy.

10. When the WAR file is successfully deployed, restart Oracle Application Server.

11. Restart Oracle Identity Manager and the Design Console.

Encrypting a New Oracle Identity Manager Password  If the password of the Oracle Identity 
Manager administrator is different from the default password, then you must encrypt 
the Oracle Identity Manager password as follows:

1. On the Oracle Identity Manager server, open a command window.

2. In the command window, change to the OIM_HOME/xellerate/ScheduleTask 
directory.

3. Enter the following command:

java -classpath PSFTBaseReconciliation .jar  \
Com.thortech.xl.Integration.peoplesoft.util.tcUtilEncryption -e \
OIM_plaintext_password

In this command, OIM_plaintext_password is the new Oracle Identity 
Manager administrator password that you want to encrypt.

Note: You can add custom attributes to be reconciled during 
incremental reconciliation. However, you must complete the 
deployment procedure before you can add custom attributes.

Refer to the "Adding Custom Attributes for Incremental 
Reconciliation" section on page 3-30 for information about the 
procedure to add custom attributes for reconciliation.

Note: The default administrator user ID is xelsysadm.
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The encrypted password is displayed in the command window.

4. Copy the encrypted password into the xlsession.properties file. This file is 
compressed in the OIM_HOME/xlclient/lib/peopleSoftUserMgmt.war file. 

5. Delete the peopleSoftUserMgmt.war file from the temporary directory where 
you extracted its contents, and then use the following command to re-create the 
file:

jar –cvf  peopleSoftUserMgmt.war

6. Ensure that the old version of the peopleSoftUserMgmt.war file is removed 
from the application server (BEA WebLogic, IBM WebSphere, JBoss Application 
Server, or Oracle Application Server) deployment directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server (BEA WebLogic, IBM WebSphere, JBoss Application Server, or Oracle 
Application Server) deployment directory.

8. Restart Oracle Identity Manager and the Design Console.

Adding Custom Attributes for Incremental Reconciliation  

Standard incremental reconciliation involves the reconciliation of predefined 
attributes. If required, you can add custom attributes to the list of fields that are 
reconciled.

The procedure to add a custom attribute for reconciliation depends on the release of 
PeopleTools that you are using:

■ Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.22

■ Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.45 
Through 8.48

Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.22
To add a custom attribute for incremental reconciliation on PeopleTools 8.22:

1. In PeopleSoft Application Designer:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Message from the Definition list, enter USR_MGMT_MSG in the Name 
Selection Criteria field, and then click Enter. The details of the 
USR_MGMT_MSG message are displayed.

c. Click the record to which you want to add custom attributes.

For example, if you want to add the ALTERNATE USER ID attribute, 
ROLEUSER_ALT, then add PSROLEXLATOPRVW under VERSION_1.

d. Select the check box for the required attribute, and then save the message.

For example, select the ALTERNATE USER ID check box.

2. Make the required changes in the PeopleCode given in the 
UserMgmtCBRecon.txt file. This file is in the 
OIM_HOME/xellerate/scripts directory. The required changes are as follows:

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data. If you do not want to add custom attributes 
for incremental reconciliation, then you can skip this section.



Configuring Oracle Identity Manager

Configuring the Target System and Oracle Identity Manager 3-31

a. At the end of the SQL statements section, edit the SQL statement to retrieve 
the column values for the new attribute and store the values in local variables.

For example, suppose you want to add the alternate user id attribute, 
ALTERNATE USER ID, to the list of attributes that are reconciled. Then, 
performing this step involves editing the SQL statement as follows, so that it 
retrieves the values of the ALTERNATE USER ID column from the table:

SQLExec("select ROLEUSER_ALT from PSROLEXLATOPRVW a where userid =:1 ", 
&userid,  &roleuser_alt);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the ROLEUSER_ALT column to the 
PSROLEXLATOPRVW tag, add the lines highlighted in bold in the following 
code sample:

/* FOR PSROLEXLATOPRVW RECORD */
&MSG_RWST.GetRow(1).PSROLEUSER_VW.ROLENAME.Value = &roles;
&MSG_RWST.GetRow(1).PSOPRALIAS.OPRALIASTYPE.Value = &type;
&MSG_RWST.GetRow(1).PSROLEXLATOPRVW.ROLEUSER_ALT.Value = &roleuser_alt

3. To extract the contents of the peopleSoftUserMgmt.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftUserMgmt.war

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. (The attributemap.properties file is one of the files extracted from 
the WAR file.) For example, you can add the following XPath for the ALTERNATE 
USER ID attribute:

Users.ROLEUSER_ALT =//Transaction/PSROLEXLATOPRVW/ROLEUSER_ALT

5. Delete the existing peopleSoftUserMgmt.war file from the temporary directory 
into which you extract it, and then enter the following command to re-create the 
file:

jar –cvf peopleSoftUserMgmt.war .

6. Delete the old version of the peopleSoftUserMgmt.war file from the 
application server deployment directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server deployment directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

Note: In the attributemap.properties file, the key part of each 
line is the text to the left of the equal (=) sign. You must ensure that the 
key part of the lines does not contain spaces. For example, Users. 
ROLEUSER_ALT, Users. ROLEUSER_ALT, Users.ROLEUSER_ALT 
are all invalid key values because they contain spaces.

See Also: Oracle Identity Manager Design Console for detailed 
instructions on performing the following steps
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a. Open the process form located in the Development Tools folder of the Oracle 
Identity Manage Design Console.

b. Click Create New Version.

c. In the Create a New Version dialog box, specify the version name in the Label 
field. Save the changes, and then close the dialog box.

d. From the Current Version list, select the newly created version.

e. On the Additional Columns tab, click Add. Add a column corresponding to 
the new attribute in the User Defined process form, UD_PSFT_BAS. For the 
example described earlier, you can add the UD_PSFT_ALT_USER column.

f. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFTBase. For the example described earlier, you can add the 
Users.ROLEUSER_ALT reconciliation field.

g. Modify the PSFTBase process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the 
example described earlier, the mapping is as follows:

Users.ROLEUSER_ALT= UD_PSFT_ALT_USER

In this example, ROLEUSER_ALT is the reconciliation field and also the 
equivalent target system attribute. As a standard, the prefix "Users." is 
added at the start of all reconciliation field names.

9. Restart Oracle Identity Manager and the Design Console.

Adding a Custom Attribute for Incremental Reconciliation on PeopleTools 8.45 
Through 8.48
To add a custom attribute for incremental reconciliation on PeopleTools 8.45 through 
8.48:

1. Make the required changes in the PeopleCode given in the 
UserMgmtCBRecon_8.45-8.47.txt or the UserMgmtCBRecon_8.48.txt 
file. These files are in the OIM_HOME/xellerate/scripts directory. The 
required changes are as follows:

a. At the end of the SQL statements section, add a SQL statement to retrieve the 
column values for the new attribute and store the values in local variables.

For example, suppose you want to add the alternate user ID attribute, 
ROLEUSER_ALT, to the list of attributes that are reconciled. Then, performing 
this step involves adding the following SQL statement to retrieve the values of 
the ROLEUSER_ALT column from the PSROLEXLATOPRVW table:

SQLExec("select ROLEUSER_ALT from PSROLEXLATOPRVW a where userid =:1 ", 
&userid,  &roleuser_alt);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the Alternate User ID column to the 
PSROLEXLATOPRVW tag, add the lines highlighted in bold in the following 
code sample:

&recnode = &fieldtypenode.AddElement("PSROLEXLATOPRVW");
&recnode.AddAttribute("class", "R");
&fields = &recnode.AddElement("ALTERNATE USER ID");
&fields.AddAttribute("type", "CHAR");
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c. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the ROLEUSER_ALT column to the 
PSROLEXLATOPRVW tag, add the lines highlighted in bold in the following 
code sample:

&datarecnode = &transnode.AddElement("PSROLEXLATOPRVW");
&datarecnode.AddAttribute("class", "R");
&datafldnode = &datarecnode.AddElement("ALTERNATE USER ID");
&textnode = &datafldnode.AddText(&roleuser_alt);

2. In PeopleSoft Application Designer, copy the contents of the 
UserMgmtCBRecon_8.45-8.47.txt or UserMgmtCBRecon_8.48.txt file 
into the savePostChange event for the USERMAINT component.

3. To extract the contents of the peopleSoftUserMgmt.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftUserMgmt.war

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the 
ROLEUSER_ALT attribute:

Users.ROLEUSER_ALT =//Transaction/PSROLEXLATOPRVW/ROLEUSER_ALT

5. Delete the existing peopleSoftUserMgmt.war file from the temporary directory 
into which you extract it, and then enter the following command to re-create the 
file:

jar –cvf peopleSoftUserMgmt.war .

6. Delete the old version of the peopleSoftUserMgmt.war file from the 
application server deployment directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server deployment directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Open the process form located in the Development Tools folder of the Oracle 
Identity Manage Design Console.

b. Click Create New Version.

c. In the Create a New Version dialog box, specify the version name in the Label 
field. Save the changes, and then close the dialog box.

d. From the Current Version list, select the newly created version.

Note: In the attributemap.properties file, the key part of each 
line is the text to the left of the equal (=) sign. You must ensure that the 
key part of the lines does not contain spaces. For example, Users. 
ROLEUSER_ALT, Users. ROLEUSER_ALT, Users.ROLEUSER_ALT 
are all invalid key values because they contain spaces.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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e. On the Additional Columns tab, click Add. Add a column corresponding to 
the new attribute in the User Defined process form, UD_PSFT_BAS. For the 
example described earlier, you can add the UD_PSFT_ALT_USER column.

f. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFTBase. For the example described earlier, you can add the 
Users.ROLEUSER_ALT reconciliation field.

g. Modify the PSFTBase process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the 
example described earlier, the mapping is as follows:

Users.ROLEUSER_ALT=UD_PSFT_ALT_USER

In this example, ROLEUSER_ALT is the reconciliation field and also the 
equivalent target system attribute. As a standard, the prefix "Users." is 
added at the start of all reconciliation field names.

9. Restart Oracle Identity Manager and the Design Console.

Limited Reconciliation  

By default, all target system records that are added or modified after the previous 
reconciliation run are reconciled during the current reconciliation run. You can 
customize the reconciliation process by specifying the subset of newly added or 
modified records that must be reconciled. You implement this form of limited 
reconciliation by creating customized queries for reconciliation. You do this by 
creating filters for the reconciliation module.

Creating a filter involves specifying a value for the UserID scheduled task attribute, 
which will be used in the SELECT query criteria to retrieve the target system records to 
be reconciled. This can be done by editing the 
configureReconciliation.properties file, which contains the OPRIDLIKE 
and UserType parameters.

For instructions to specify values for the UserID scheduled task attribute, refer to the 
"Specifying Values for the Scheduled Task Attributes" section on page 3-19.

Configuring Trusted Source Reconciliation

While configuring the connector, the target system can be designated as a trusted 
source or a target resource. If you designate the target system as a trusted source, then 
both newly created and modified user accounts are reconciled in Oracle Identity 
Manager. If you designate the target system as a target resource, then only modified 
user accounts are reconciled in Oracle Identity Manager.

1. Import the XML file for trusted source reconciliation, 
PSFTBaseXellerateUser.xml, by using the Deployment Manager. This section 
describes the procedure to import the XML file.

Note: The following procedure can be implemented regardless of 
whether you select full or incremental reconciliation. You can skip this 
section if you do not want to designate the target system as a trusted 
source for reconciliation.
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2. Specify values for the attributes of the PSFT Base Trusted User 
Reconciliation scheduled task. This procedure is described later in this guide.

To configure trusted source reconciliation:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management. A dialog box for opening 
files is displayed.

4. Locate and open the PSFTBaseXellerateUser.xml file, which is in the 
OIM_HOME/xlclient directory. Details of this XML file are shown on the File 
Preview page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Import. 

8. In the message that is displayed, click Import to confirm that you want to import 
the XML file and then click OK.

Configuring Provisioning
As mentioned earlier in this guide, provisioning involves creating or modifying a 
user's account information on the target system through Oracle Identity Manager.

This section discusses the following topics related to configuring provisioning:

■ Compiling Adapters

■ Adding Custom Attributes for Provisioning

Compiling Adapters

Adapters are used to implement provisioning functions. The following adapters are 
imported into Oracle Identity Manager when you import the connector XML file:

■ adpPSFTCREATEUSER

■ adpPSFTUPDATEUSER

■ adpPSFTRESETPASSWORD

Caution: Only one target system can be designated as a trusted 
source. If you import the PSFTBaseXellerateUser.xml file while 
you have another trusted source configured, then both connector 
reconciliations would stop working.

Note: You must perform this procedure if you want to use the 
provisioning features of Oracle Identity Manager for this target 
system.

See Also: The "Supported Functionality" section on page 1-4 for a 
listing of the provisioning functions that are available with this 
connector
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■ adpPSFTUNLOCKUSER

■ adpPSFTLOCKUSER

■ adpPSFTUPDATEUSEREMPID

■ adpPSFTADDORDELETEROLE

■ adpPSFTADDORDELETEEMAIL (PeopleTools 8.45 through 8.48 only)

You must compile these adapters before they can be used in provisioning operations.

To compile adapters by using the Adapter Manager form:

1. Open the Adapter Manager form.

2. To compile all the adapters that you import into the current database, select 
Compile All.

To compile multiple (but not all) adapters, select the adapters you want to 
compile. Then, select Compile Selected.

3. Click Start. Oracle Identity Manager compiles the selected adapters.

4. If Oracle Identity Manager is installed in a clustered environment, then copy the 
compiled adapters from the OIM_HOME/xellerate/Adapter directory to the 
same directory on each of the other nodes of the cluster. If required, overwrite the 
adapter files on the other nodes.

If you want to compile one adapter at a time, then use the Adapter Factory form.

To view detailed information about an adapter:

1. Highlight the adapter in the Adapter Manager form.

2. Double-click the row header of the adapter, or right-click the adapter.

3. Select Launch Adapter from the shortcut menu that is displayed. Details of the 
adapter are displayed.

Adding Custom Attributes for Provisioning

To add a custom attribute for provisioning:

Note: Click Compile Previously Failed to recompile only those 
adapters that were not compiled successfully. Such adapters do not 
have an OK compilation status.

See Also: Oracle Identity Manager Tools Reference Guide for 
information about using the Adapter Factory and Adapter Manager 
forms

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data. If you do not want to add custom attributes 
for provisioning, then you can skip this section. 

See Also: Oracle Identity Manager Design Console Guide
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1. Modify the attributemapping_prov.properties file, which is in the 
OIM_HOME/xellerate/XLIntegrations/PSFTBase/config directory. At 
the end of this file, some of the attribute definitions are preceded by comment 
characters. You can uncomment the definitions of attributes that you want to use 
any one of them to make it a part of the provisioning attributes.

You can also add new attributes in this file. The format that you must use is as 
follows:

OimAttributeName=TargetAttributeName

For example:

If you want to add the AlternateUserID field, then add the following line in the 
attributemapping_prov.properties file:

AlternateUserID=AlternateUserID

Add a new column in the process form.

a. Open the process form. This form is in the Development Tools folder of the 
Oracle Identity Manager Design Console.

b. Click Create New Version.

c. In the Create a New Version dialog box, specify the version name in the Label 
field, save the changes, and then close the dialog box.

d. From the Current Version list, select the newly created version.

e. On the Additional Columns tab, click Add.

f. Specify the new field name and other values.

2. Add a new variable in the variable list.

a. Open the Adapter Factory form. This form is in the Development Tools folder 
of the Oracle Identity Manager Design Console.

b. Click the Query for Records icon.

c. On the Adapter Factory Table tab, double-click the adpPSFTCREATEUSER  
adapter from the list.

d. On the Variable List tab, click Add.

e. In the Add a Variable dialog box, specify the required values and then save 
and close the dialog box.

3. Define an additional adapter task for the newly added variable in the 
adpPSFTCREATEUSER adapter.

a. On the Adapter Tasks tab of the Adapter Factory form, click Add.

b. In the Adapter Task Selection dialog box, select Functional Task, select Java 
from the list of functional task types, and then click Continue.

Note: You must ensure that the OimAttributeName value that you 
specify does not contain spaces.

See Also: Oracle Identity Manager Design Console for more 
information about this step and the remaining steps of this procedure
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c. In the Object Instance Selection dialog box, select the Persistent instance and 
then click Continue.

d. In the Add an Adapter Factory Task dialog box, specify the task name, select 
the setProperty method from the Method list, and then click Save.

e. Map the application method parameters, and then save and close the dialog 
box. To map the application method parameters:

For the "Output: String Return variable (Adapter Variable)" parameter:

i. From the Map to list, select Literal.

ii. From the Name list, select Return variable.

For the "Input: String input (Adapter Variable)" parameter:

i. From the Map to list, select Adapter Variables.

ii. From the Name list, select Input.

For the "Input: String Status (Literal)" parameter:

i. From the Map to list, select Literal.

ii. From the Name list, select String.

iii. In the Value field, enter Status.

For the "Input: String Status (Adapter Variable)" parameter:

i. From the Map to list, select Adapter Variables.

ii. From the Name list, select Status.

f. Repeat Steps b through e to create more adapter tasks.

4. Create an additional adapter task to set the input variable.

a. Open the Adapter Factory form. This form is in the Development Tools folder 
in the Oracle Identity Manager Design Console.

b. On the Adapter Tasks tab, click Add.

c. In the Adapter Task Selection dialog box, select Logic Task, select SET 
VARIABLE from the list, and then click Continue.

d. In the Edit Set Variable Task Parameters dialog box, select input from the 
Variable Name list, select Adapter Task from the Operand Type list, and the 
Operand Qualifier as the Adapter Task that you have created in the previous 
step. Then, click Save.

5. Map the process form columns and adapter variables for the Create User process 
task as follows:

a. Open the Process Definition form. This form is in the Process Management 
folder of the Design Console.

b. Click the Query for Records icon.

c. On the Process Definition Table tab, double-click the PSFTBase process.

d. On the Tasks tab, double-click the Create User task.

e. In the Closing Form dialog box, click Yes.

f. On the Integration tab of the Editing Task Columns Create User dialog box, 
map the unmapped variables, and then save and close the dialog box. To map 
an unmapped variable:
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i. Double-click the row in which N is displayed in the Status column. The 
value N signifies that the variable is not mapped.

ii. From the Map to list in the Edit Data Mapping for Variables dialog box, 
select Process Data.

iii. From the Qualifier list, select the name of the variable.

Repeat Steps i through iii for all unmapped variables.

Repeat Steps 1 through 5 if you want to add more attributes.
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4
Testing and Troubleshooting

After you deploy the connector, you must test it to ensure that it functions as expected.  
This chapter discusses the following topics related to connector testing:

■ Testing Reconciliation

■ Testing Provisioning

■ Troubleshooting

Testing Reconciliation
Running test cases for reconciliation involves verifying that the PeopleSoft Listener 
Web application can reconcile user accounts into Oracle Identity Manager. The 
following sections provide instructions to perform this test.

Prerequisites for Testing the PeopleSoft Listener Web Application
The following are prerequisites for testing the PeopleSoft Listener Web application:

■ Ensure that the Microsoft Windows scripting engine is installed. This is required to 
run VBScript files.

■ Ensure that the PeopleSoft XML message schema is described in the 
USR_MGMT_MSG.xml file, which is in the OIM_HOME/xellerate/test 
directory.

Testing the PeopleSoft Listener Web Application
To test the PeopleSoft Listener Web application:

1. In the OIM_HOME/xellerate/test/cbrecon/psft-xel-test.vbs file:

■ Modify the value of the ps_server_url variable so that it points to the URL 
for the PeopleSoft Listener Web application.

■ Specify the required PeopleSoft attributes and user data values in the 
ExecuteATM function.

2. Run psft-xel-test.vbs. Ensure that the script runs without any errors.

When the script is run, it creates a reconciliation event. Verify that the reconciliation 
event is created in Oracle Identity Manager and that the event contains the data that 
you specify in the VBScript file.
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Performing Trial Reconciliation
Refer to the "Limited Reconciliation" section on page 3-23.

Testing Provisioning
You can use the testing utility to identify the cause of problems associated with 
connecting to the target system and performing basic operations on the target system.

Before you use the testing utility, you must set the required values in the 
config.properties file. This file is in the 
OIM_HOME/xellerate/XLIntegrations/PSFTBase/config directory.

Use the information in the following table to modify the default attributes of the 
config.properties file.

Name Description Sample Value

serverName IP address or host name of the PeopleSoft Enterprise 
Applications server

172.21.109.95

serverPort Port at which the PeopleSoft Enterprise Applications 
server is listening

9000

admin User ID of the PeopleSoft Enterprise Applications server 
administrator

PS

ciName Component interface used to load user data in PeopleSoft 
Enterprise Applications

USER_PROFILE

NumberOfRetries Number of times the connection to the target system must 
be retried before the InvocationTargetException is 
thrown

2

DelayBetweenRetr
ies

Time difference between subsequent retries (in 
milliseconds)

10000

action Action to be performed You can specify one of the 
following values:

CONNECT

CREATE

UPDATEUSERINFO

UPDATEUSER_EMPID

UPDATEPASSWORD

userId User login ID PSFTTEST

userDescription Description of the user PSFTTEST

primaryEmailAddr
ess

Primary e-mail address PSFTTEST@psft.com

primaryEmailType E-mail type of the primary e-mail account BUS

password Password of the user password

languageCode Language code for the user ENG

currencyCode Currency code for the user USD

recName Used to validate the employee ID during user 
provisioning in PeopleSoft Enterprise Applications

PERSONAL_DATA

empId Employee ID for the user A10000
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After you specify values in the config.properties file, run one of the following 
files:

For UNIX:

OIM_HOME/xellerate/XLIntegrations/tests/scripts/PSFTBase.sh

For Microsoft Windows

OIM_HOME\xellerate\XLIntegrations\tests\scripts\PSFTBase.bat

Troubleshooting
The following table lists solutions to some commonly encountered issues associated 
with the PeopleSoft User Management connector.

primaryPermissio
nList

Primary permission list for the user HCCPAM1

userIdAlias User ID alias PSFTTEST1

symbId Specifies the AccessId associated with the user profile

The AccessId specifies whether or not the user has 
sufficient privileges on the PeopleSoft Enterprise 
Applications database.

PS89

attrName Name of the attribute to be updated You can specify one of the 
following values:

USER_DESCRIPTION

EMAIL_ADDRESS

EMAILTYPE

MULTI_LANGUAGE_CODE

LANGUAGE_CODE

CURRENCY_CODE

attrValue Value of the attribute to be updated The value that you provide 
must correspond to the 
attribute name that you 
specify as the value of the 
attrName parameter.

Problem Description Solution

Oracle Identity Manager cannot 
establish a connection with the 
PeopleSoft Enterprise Applications 
server.

■ Ensure that the PeopleSoft Enterprise 
Applications server is running.

■ Ensure that Oracle Identity Manager is 
running.

■ Ensure that all the adapters have been 
compiled.

■ Use the IT Resources form to examine the 
Oracle Identity Manager record. Ensure that 
the IP address, admin ID, and admin 
password are correct.

Name Description Sample Value
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The Operation Fail message is 
displayed on the Oracle Identity 
Manager Administrative and User 
Console.

■ Ensure that the values for the attributes do not 
contain delimiter characters, such as white 
space and commas.

■ Ensure that the attribute values do not exceed 
allowable length.

The Create User adapter is triggered 
even when the pre-populate adapter 
is run successfully.

Set the property associated with the user ID 
attribute in the process form as required.

The PSFTBaseProvisioning.jar 
file is not accessible while running 
OIM_HOME/xellerate/XLIntegra
tions/tests/scripts/PSFTBase
.sh testing utility.

It can be resolved by running the following 
command on the file:

dos2unix ./PSFTBase.sh

You might encounter the following 
error when you run the testing utility 
for provisioning:

java.io.FileNotFoundExceptio
n: 
null\XLIntegrations\PSFTBase
\config\attributemapping_pro
v.properties

Update the 
OIM_HOME/xellerate/XLIntegrations/test
s/scripts/PSFTBase.sh file with following 
details:

XL.HomeDir=OIM_HOME

Problem Description Solution
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5
Known Issues

The following are known issues associated with this release of the connector:

■ Secure Sockets Layer (SSL) connections are not supported.

■ The connector files for PeopleTools 8.22 and PeopleTools 8.45 through 8.48 cannot 
be deployed on the same Oracle Identity Manager installation.

■ Some Asian languages use multibyte character sets. If the character limit for the 
fields in the target system is specified in bytes, then the number of Asian-language 
characters that you can enter in a particular field may be less than the number of 
English-language characters that you can enter in the same field. The following 
example illustrates this limitation:

Suppose you can enter 50 characters of English in the User Last Name field of the 
target system. If you were using the Japanese language and if the character limit 
for the target system fields were specified in bytes, then you would not be able to 
enter more than 25 characters in the same field.
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A
Attribute Mappings Between Oracle Identity
Manager and PeopleSoft User Management

The following table discusses attribute mappings between Oracle Identity Manager 
and PeopleSoft User Management.

Oracle Identity Manager 
Attribute

PeopleSoft User 
Management Attribute Description

Lookup Fields

LanguageCode PSXLATITEM.FIELDVALUE, 
PSXLATITEM.XLATLONGN
AME

Language code

EmployeeId PS_PERSONAL_DATA.EMP
LID, 
PS_PERSONAL_DATA.NAM
E

Employee ID

CurrencyCode PS_CURRENCY_CD_TBL.C
URRENCY_CD, 
PS_CURRENCY_CD_TBL.D
ESCR

Currency Code

PermissionList PSCLASSDEFN.CLASSID,PS
CLASSDEFN.CLASSDEFND
ESC

Permission List

EmailType PSXLATITEM.FIELDVALUE, 
PSXLATITEM.XLATLONGN
AME

E-mail Type

UserRoles PSROLEDEFN.ROLENAME, 
PSROLEDEFN.DESC

User Roles

User Attributes

User Id PSOPRDEFN.OPRID User login ID

User Description PSOPRDEFN.OPRDEFNDES
C

Description of user

Employee Id PSOPRDEFN.EMPLID Employee ID

Primary Email Address PSUSEREMAIL.EMAILID E-mail address (primary e-mail account)

Primary Email Type PSUSEREMAIL.EMAILTYPE Email type (primary e-mail account)

Multi Language Code PSOPRDEFN.MULTILANG Multilanguage code

Language Code PSOPRDEFN.LANGUAGE_
CD

Language code
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Currency Code PSOPRDEFN.CURRENCY_C
D

Currency code

User Id Alias PSOPRDEFN.USERIDALIAS Alias of user login ID

Row Security Permission 
List

PSOPRDEFN.ROWSECCLAS
S

Row security parameter

Process Profile Permission 
List

PSOPRDEFN.PRCSPRFLCLS Process profile parameter

Navigator Home Permission 
List

PSOPRDEFN.DEFAULTNAV
HP

Navigator home page address

Primary Permission List PSOPRDEFN.OPRCLASS Primary permission list

Email Address PSUSEREMAIL.EMAILID E-mail address

Email Type PSUSEREMAIL.EMAILTYPE E-mail type

RoleName PSROLEUSER_VW.ROLENA
ME

Role name

Oracle Identity Manager 
Attribute

PeopleSoft User 
Management Attribute Description
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